Supervisory Control System
Instruction Manual

RYAN DOWNS
RALPH PAUL
ERIC RUNNERSTROM

MPR Associates
Alexandria, VA

HUNG PHAM
Hughes Associates, Inc.
Baltimore, MD

FREDERICK W. WILLIAMS
Navy Technology Center for Safety and Survivability
Chemistry Division

February 4, 2005

Approved for public release; distribution is unlimited.
1. REPORT DATE (DD-MM-YYYY) 04-02-2005
2. REPORT TYPE Memorandum
3. DATES COVERED (From - To) October 2002-October 2003

4. TITLE AND SUBTITLE Supervisory Control System Instruction Manual

5a. CONTRACT NUMBER
5b. GRANT NUMBER
5c. PROGRAM ELEMENT NUMBER
5d. PROJECT NUMBER 61-8244-A-5-5
5e. TASK NUMBER
5f. WORK UNIT NUMBER

6. AUTHOR(S) Ryan Downs,* Ralph Paul,* Eric Runnerstrom,* Hung Pham,† and Frederick W. Williams

7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES)
   Naval Research Laboratory, Code 6180
   4555 Overlook Avenue, SW
   Washington, DC 20375-5320

8. PERFORMING ORGANIZATION REPORT NUMBER
   NRL/MR/6180-05-8857

9. SPONSORING / MONITORING AGENCY NAME(S) AND ADDRESS(ES)
   Office of Naval Research, Code 334
   800 North Quincy Street
   Arlington, VA 22217-5000

10. SPONSOR / MONITOR’S ACRONYM(S)
11. SPONSOR / MONITOR’S REPORT NUMBER(S)

12. DISTRIBUTION / AVAILABILITY STATEMENT
   Approved for public release; distribution is unlimited.

13. SUPPLEMENTARY NOTES
    *MPR Associates, Alexandria, VA 22314
    †Hughes Associates Inc., Baltimore, MD 21227

14. ABSTRACT
    The Supervisory Control System (SCS) installed aboard the ex-USS Shadwell is a functional example of a damage control (DC) focused distributed control system. SCS, as used in this report, is defined as a system automated to some extent, which monitors and controls multiple ship systems and enables a human supervisor to interact with the ship systems through a human-centered interface and to manage human actions so that the responses of the systems and the actions of the personnel complement one another. The SCS provides the operator with reliable situation awareness regarding the operability of the ship’s damage control functions. The SCS assimilates raw data into information and presents the information visually to the operator. The SCS automatically handles complicated decisions, such as fluid system rupture detection and isolation, fire boundary locations, and resource management. The SCS also handles simple tasks, such as managing the water mist suppression system to minimize water usage while maximizing effectiveness.

15. SUBJECT TERMS
    Automation; Smart valve; Damage control; Early warning

16. SECURITY CLASSIFICATION OF:
    a. REPORT Unclassified
    b. ABSTRACT Unclassified
    c. THIS PAGE Unclassified

17. LIMITATION OF ABSTRACT UL
18. NUMBER OF PAGES 110

19a. NAME OF RESPONSIBLE PERSON Frederick W. Williams
19b. TELEPHONE NUMBER (include area code) (202) 767-2002

Standard Form 298 (Rev. 8-98)
Prescribed by ANSI Std. Z39.18
## Contents

1 **Introduction** ........................................................................................................................... 1-1  
   - Purpose ................................................................................................................................. 1-1  
   - Overview ............................................................................................................................... 1-1  
   - Scope .................................................................................................................................. 1-1  
2 **System Architecture** ................................................................................................................. 2-1  
   - Ideal Logical Architecture .................................................................................................... 2-1  
   - Ideal Software Architecture ................................................................................................. 2-2  
   - Actual Software Architecture .............................................................................................. 2-3  
   - Physical Architecture .......................................................................................................... 2-4  
3 **Startup Procedure** ..................................................................................................................... 3-1  
   - PC Locations: ....................................................................................................................... 3-1  
   - Live Fire Testing ................................................................................................................... 3-2  
     - Description ........................................................................................................................ 3-2  
     - Pre-startup procedure ......................................................................................................... 3-2  
     - Startup Procedure ........................................................................................................... 3-2  
     - Live Fire Test Procedure .................................................................................................. 3-4  
     - Resetting Live Fire Test .................................................................................................... 3-4  
   - Training/Simulation ................................................................................................................ 3-6  
     - Description ....................................................................................................................... 3-6  
     - Pre-startup procedure ......................................................................................................... 3-6  
     - Startup Procedure ........................................................................................................... 3-6  
     - Training/Simulation Procedure ....................................................................................... 3-7  
     - Resetting Training/Simulation .......................................................................................... 3-8  
   - General Monitoring ................................................................................................................ 3-9  
     - Description ....................................................................................................................... 3-9  
     - Pre-startup procedure ......................................................................................................... 3-9  
     - Startup Procedure ........................................................................................................... 3-9
Contents (cont’d.)

General Monitoring Procedure ................................................................. 3-10
Resetting General Monitoring Procedure .................................................. 3-11
Rupture Demonstration ............................................................................ 3-12
  Description ........................................................................................................ 3-12
  Pre-startup procedure ...................................................................................... 3-12
  Start-up Procedures ........................................................................................ 3-12
  Rupture Procedure .......................................................................................... 3-13
  Resetting the Rupture Demo ........................................................................... 3-14

4 SCS System Capabilities .............................................................................. 4-1

5 SCS Display ................................................................................................. 5-1
  Locations ........................................................................................................... 5-1
  Purpose ............................................................................................................. 5-1
  Overview .......................................................................................................... 5-1
    Main View Window .......................................................................................... 5-3

6 Communications Plotter Display .................................................................. 6-1
  Location ............................................................................................................. 6-1
  Purpose ............................................................................................................. 6-1
  Overview .......................................................................................................... 6-2
    Message Management Bar (Top) ................................................................... 6-2
    Report Source Pane (Middle, Left) ................................................................. 6-2
    Compartment Pane (Middle, Left-Center) ....................................................... 6-2
    Damage Report Type Pane (Middle, Right-Center) ......................................... 6-2
    Damage Report Details Pane (Middle, Right) .................................................. 6-2
    Ship View Pane (Bottom, Left) ...................................................................... 6-2
    Current Report Info Pane (Bottom, Right) ....................................................... 6-3
  Operation .......................................................................................................... 6-3

7 Video Server Display .................................................................................. 7-1
## Contents (cont’d.)

<table>
<thead>
<tr>
<th>Module</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>7-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>7-1</td>
</tr>
<tr>
<td>Overview</td>
<td>7-2</td>
</tr>
<tr>
<td>Operation</td>
<td>7-3</td>
</tr>
<tr>
<td><strong>8 Decision Aid Module</strong></td>
<td>8-1</td>
</tr>
<tr>
<td>Location</td>
<td>8-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>8-1</td>
</tr>
<tr>
<td>Overview</td>
<td>8-1</td>
</tr>
<tr>
<td>Startup</td>
<td>8-3</td>
</tr>
<tr>
<td>Shutdown</td>
<td>8-3</td>
</tr>
<tr>
<td><strong>9 Common Database</strong></td>
<td>9-1</td>
</tr>
<tr>
<td>Location</td>
<td>9-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>9-1</td>
</tr>
<tr>
<td>Overview</td>
<td>9-1</td>
</tr>
<tr>
<td><strong>10 PreHit Interface Module</strong></td>
<td>10-1</td>
</tr>
<tr>
<td>Location</td>
<td>10-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>10-1</td>
</tr>
<tr>
<td>Overview</td>
<td>10-1</td>
</tr>
<tr>
<td>Threatening Track Info</td>
<td>10-2</td>
</tr>
<tr>
<td>Threat Control Buttons</td>
<td>10-3</td>
</tr>
<tr>
<td>Scenario Status</td>
<td>10-3</td>
</tr>
<tr>
<td>Adding a Scenario</td>
<td>10-4</td>
</tr>
<tr>
<td>Running a Scenario</td>
<td>10-5</td>
</tr>
<tr>
<td><strong>11 Fire Spread Simulator Module</strong></td>
<td>11-1</td>
</tr>
<tr>
<td>Location</td>
<td>11-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>11-1</td>
</tr>
<tr>
<td>Overview</td>
<td>11-1</td>
</tr>
</tbody>
</table>
## Contents (cont’d.)

<table>
<thead>
<tr>
<th>Module</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running a Single Point Fire Scenario</td>
<td>11-4</td>
</tr>
<tr>
<td>Running a Mass Conflagration Fire Scenario</td>
<td>11-4</td>
</tr>
<tr>
<td><strong>12 Firemain Interface Module</strong></td>
<td>12-1</td>
</tr>
<tr>
<td>Location</td>
<td>12-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>12-1</td>
</tr>
<tr>
<td>Overview</td>
<td>12-1</td>
</tr>
<tr>
<td>Startup</td>
<td>12-3</td>
</tr>
<tr>
<td>Shutdown</td>
<td>12-3</td>
</tr>
<tr>
<td><strong>13 WaterMist Interface Module</strong></td>
<td>13-1</td>
</tr>
<tr>
<td>Location</td>
<td>13-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>13-1</td>
</tr>
<tr>
<td>Overview</td>
<td>13-1</td>
</tr>
<tr>
<td>Startup</td>
<td>13-2</td>
</tr>
<tr>
<td>Shutdown</td>
<td>13-2</td>
</tr>
<tr>
<td><strong>14 Door Closure Interface Module</strong></td>
<td>14-1</td>
</tr>
<tr>
<td>Location</td>
<td>14-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>14-1</td>
</tr>
<tr>
<td>Overview</td>
<td>14-1</td>
</tr>
<tr>
<td>Startup</td>
<td>14-2</td>
</tr>
<tr>
<td>Shutdown</td>
<td>14-2</td>
</tr>
<tr>
<td><strong>15 Early Warning Fire Detection System (EWFDS) Interface Module</strong></td>
<td>15-1</td>
</tr>
<tr>
<td>Location</td>
<td>15-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>15-1</td>
</tr>
<tr>
<td>Overview</td>
<td>15-1</td>
</tr>
<tr>
<td>Startup</td>
<td>15-2</td>
</tr>
<tr>
<td>Shutdown</td>
<td>15-2</td>
</tr>
<tr>
<td><strong>16 MASSCOMP Interface Module</strong></td>
<td>16-1</td>
</tr>
</tbody>
</table>
## Contents (cont’d.)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>16-1</td>
</tr>
<tr>
<td>Purpose</td>
<td>16-1</td>
</tr>
<tr>
<td>Overview</td>
<td>16-2</td>
</tr>
<tr>
<td>Startup</td>
<td>16-3</td>
</tr>
<tr>
<td>Shutdown</td>
<td>16-3</td>
</tr>
<tr>
<td>17 References</td>
<td>17-1</td>
</tr>
<tr>
<td>A Database Structure</td>
<td>A-1</td>
</tr>
<tr>
<td>B Establishing an ODBC Connection</td>
<td>B-1</td>
</tr>
<tr>
<td>C Modifying the MASSCOMP Channel Listing</td>
<td>C-1</td>
</tr>
<tr>
<td>Relevant Database Tables</td>
<td>C-1</td>
</tr>
<tr>
<td>Inserting a New Instrument</td>
<td>C-2</td>
</tr>
<tr>
<td>Deleting an Existing Instrument</td>
<td>C-3</td>
</tr>
<tr>
<td>Update an Existing Instrument</td>
<td>C-3</td>
</tr>
<tr>
<td>Check for a Correct Sensor Update</td>
<td>C-4</td>
</tr>
</tbody>
</table>
Introduction

PURPOSE

This document serves as an operational manual and system overview for the Supervisory Control System developed under the Damage Control Automation for Reduced Manning (DC-ARM) program.

OVERVIEW

The Supervisory Control System (SCS) installed aboard the ex-USS SHADWELL [1] is a functional example of a damage control (DC) focused distributed control system. SCS, as used in this report, is defined as:

A system, automated to some extent, which monitors and controls multiple ship systems and enables a human supervisor to interact with the ship systems through a human-centered interface and to manage human actions so that the responses of the systems and the actions of the personnel complement one another.

The SCS provides the operator with reliable situation awareness regarding the operability of the ship's damage control functions. The SCS assimilates raw data into information and presents the information visually to the operator. The SCS automatically handles complicated decisions such as fluid system rupture detection and isolation, fire boundary locations, and resource management. The SCS also handles simple tasks such as managing the water mist sprinkling system to minimize water usage while maximizing effectiveness. The goal is to automate mundane tasks which are not an efficient use of the operator's time and complex tasks too complicated for the operator to quickly manage, appropriate for a computer allowing the human to focus on maintaining situational awareness.

SCOPE

This document provides an understanding of the system architecture, software module functionality and operation, instructions for simulations, demonstrations and live-fire exercises, and computer hardware and software requirements. Section 2 describes the logic, software, hardware and physical architecture of the SCS. Section 3 provides operating instruction for various situations, while Section 4 provides an SCS functionality overview. Sections 5 through 17 provide a functional overview and operating guide for each of the SCS software modules.

This section describes the logical architecture of a conceptual SCS system, the ideal software architecture used to implement the logical architecture, the actual software architecture used to take advantage of existing ship damage control systems and the physical hardware architecture used to support the actual software architecture.

**IDEAL LOGICAL ARCHITECTURE**

The SCS architecture concept is designed to be robust and survivable. The conceptual SCS logical architecture is shown in Figure 2-1. This Figure shows how information flows between sensors, actuators, and logic modules. An SCS logic module is a collection of functional concepts grouped by common purpose. Each logic module can access information and data from other logic modules located below them as seen in Figure 2-1, but the logic module only uses the minimum amount of information to perform its function, limiting the amount of information traveling across the ship’s network. For example, each compartment on the ship has a generic logic module responsible for monitoring environmental conditions and controlling installed fire protection systems within the compartment. There are also logic modules designed for monitoring and controlling the firemain, controlling the WaterMist system, managing fire boundaries and managing personnel resources.
Raw data is passed in to the lowest logic modules (compartment and components logic modules) where it is synthesized into basic information. That basic information is passed upward to the zone and system logic modules where it is combined with information from other compartments and components respectively to form a more cohesive description of the situation in each region. The ship level logic assimilates all of the information from all zones and systems to form the most comprehensive assessment of the state of the ship. These decisions, recommendations and information are presented to the operators in a coherent display providing situation awareness.

**IDEAL SOFTWARE ARCHITECTURE**

Figure 2-2 shows the ideal software architecture for the logical architecture shown in Figure 2-1. Raw data is collected close to the source by compartment or component software modules. The data is synthesized into basic information and deposited into the common database where the zone and system software modules respectively can access the basic information from all compartments and components within its domain (compartsments within the same zone, or components belonging to the same system). The zone and system software modules formulate more complex information and update the common database. The ship level software module collects all of the information from all of the zones and systems on the ship and presents the operators with the coherent display proving situation awareness. An SCS software module is the software implementation of the logic modules discussed above. Ideally, the logical and software architecture and modules should differ as little as possible. In this situation, the logic and software architectures only differ in the mechanics of information transmission between
modules. The information from each module is deposited into the Common Database for other software modules to use. All other software module functionality is identical to the logic module functionality presented above.

![SCS Software Architecture Diagram]

**Figure 2-2. SCS Software Architecture**

**ACTUAL SOFTWARE ARCHITECTURE**

Based on existing data collection and control systems already installed or under development aboard the ex-USS SHADWELL, the software architecture of the SCS was modified (Figure 2-3) to take advantage of these existing systems such as, the MASSCOMP data acquisition system, Early Warning Fire Detection System (EWFDS) data collection and calibration program, Door Closure calibration program and database and the WaterMist control hardware.
PHYSICAL ARCHITECTURE

For the ease of demonstration and testing, the physical hardware, where the software modules reside, was scaled back to a limited number of dedicated SCS personal computers (PCs). Figure 2-4 shows the current SCS physical architecture aboard the ex-USS SHADWELL as demonstrated in September 2001 [2] and February 2002 [3] containing all SCS and non-SCS components required for optimum SCS operation.

For maintenance concerns, the physical architecture of the SCS is of interest. All of the computers are connected to the ship’s 1Gb fiber optic network, thus connecting all of the PCs and other networked components to each other. Where available, proper PC names were used and physical hardware locations were noted. All SCS computers are connected to the common database via a Microsoft Open Database Connectivity (ODBC) connection and use the Microsoft NetBEUI communication protocol, a name-based TCP/IP derivative.
3

Startup Procedure

The SCS can be started differently based on the type of exercise being performed. There are four customized startup procedures included in this instruction manual: Live Fire Testing, Training/Simulation, General Ship Monitoring and Rupture Demo.

PC LOCATIONS:

- Control Room
  - MPR_SCS_SERVER
  - MPR_SCS_TEST
  - SHADWELL-PC5
- Damage Control (DC) Central
  - MPR_SCS_DCA
  - MPR_SCS_WATCH
  - MPR_SCS_COMMS
- Data Acquisition Closet (DAQ) (Node Room #1)
  - MPR_SCS_VIDEO

IMPORTANT NOTES:
- CAUTION: Starting the SCS allows the operators to control components on the ship. Damage to equipment and/or human injury may result from improper actuation of components of the SCS. This includes valves and pumps but also includes simulation programs that may cause the SCS to AUTOMATICALLY actuate valves and pumps.
- For the SCS to connect properly the user names and passwords MUST be strictly adhered to, including capitalization.
- When securing the SCS, ALWAYS secure the Decision Aid Module FIRST. After that, the order of shut down is irrelevant.
LIVE FIRE TESTING

Description

The Live Fire Testing involves lighting a fire somewhere in the ship and using the SCS system as part of the casualty detection, containment and control response. This effort requires the full cooperation of the ship’s force, test team, safety team and fleet participants.

Pre-startup procedure

i. Notify cognizant personnel before starting any portion of the SCS.
ii. Check with informed personnel regarding the state of the test area and all components controlled by the SCS.

Startup Procedure

CONTROL ROOM

MPR_SCS_SERVER PC

1. Turn on the MPR_SCS_SERVER PC.

MPR_SCS_TEST PC

2. Start the MassComp scanning.
3. Turn on the MPR_SCS_TEST PC.
4. Start the MassComp Interface Module by clicking the “1) MassComp Interface” icon located on the desktop.
5. (If performing a rupture as part of the scenario) Start the LNS DDE Gateway Module by clicking the “2) LNS DDE Gateway” icon located on the desktop.
6. (If performing a rupture as part of the scenario) Start the Firemain Interface Module by clicking the “3) DDE Gateway” icon located on the desktop.
7. DDE Gateway Program - Change the “Network Name” to “shadwell_01_02” to connect to the SHADWELL firemain network modified on January 2002.
8. DDE Gateway Program - Click “Connect to DDE Server” button to begin the network connection process.

   The program should have a short list of nodes to connect to. Wait for this to finish. If a device cannot connect, try again. If program crashes, close application and repeat steps 4-6 again.

SHADWELL PC-5

9. Turn on SHADWELL-PC5.
10. Start the PreHit Interface Module by clicking the “ShadScenario.exe” icon located on the desktop.
11. PreHit Interface Module – Click “Reset Scenario/Clear Predicted Damage” button to clear any damage signals left in the database from a previous exercise.
12. PreHit Interface Module – Add a scenario by following instructions in Section 10, “Adding a Scenario” if no scenario is present.

3-2
13. Turn on all three PCs in DCC.
14. Turn on all three video projectors.

**MPR_SCS_WATCH PC**
15. Start the SCS Display by clicking on the “SCS Display w/ Perf Mon” icon located on the desktop.
16. SCS Display - Login in “Full Control Mode” to control firemain components, “Operator Type” as “General” and click the “OK” button. This brings up the display.
17. (Optional) Reorient all of the windows to properly fill all three screens.

**MPR_SCS_DCA PC**
18. SCS Display - Repeat steps 15 and 16 for the DCA PC located in the gray cabinet.
19. SCS Display - Click the “Clear Pred.”, “Clear All”, “Clear Comp.” Buttons on either of the SCS Display programs to clear any damage signals left in the database from a previous exercise.

**MPR_SCS_COMMS PC**
20. Start the Fire Spread Simulation Module by clicking the “DCTester” icon located on the desktop.
21. Fire Spread Simulation Module - Click OK when a window opens that says “Shadwell data source provider is FALSE”.
22. Fire Spread Simulation Module - Click the “Reset all compartment damage/reset all WaterMist” button to reset all of the thermocouple and WaterMist data left in the database from a previous exercise.
23. Fire Spread Simulation Module - Close the application as it is not needed during a live fire exercise.

**CONTROL ROOM**
**MPR_SCS_SERVER PC**
24. Start Decision Aid Module by clicking on the “Supervisory Control” icon located on the desktop.
25. Supervisory Control Program - Click “Reset all A&E” button to clear all actions and events from the displays in DCC.
26. Supervisory Control Program - Pick the first item “Ship Level Logic Module” from the drop-down list box to assign a primary function.
27. Supervisory Control Program - Click OK to start. All of the check boxes will be checked after 10 seconds.

**DAQ**
**MPR_SCS_VIDEO PC**
28. Start the PC in DAQ.
29. Start Video Server Display by clicking the “SCS Video Server” icon located on the desktop.
Live Fire Test Procedure

Pre Impact

**Shadwell PC-5**

1. Turn on the Shadwell PC-5.
2. ShadScenario Program – Start the scenario following the instruction in Section 10, “Running a Scenario.” The SCS will detect the hostile platform and post the information in the SCS Display’s PreHit Window.

**MPR_SCS_DCA or MPR_SCS_WATCH**

3. The SCS will post and remove “PreHit” events and actions from the Decision Aid Window in the SCS Display.
4. Follow recommended actions in Decision Aid Window. Remember to update the action status when actions are ordered and completed.

Post impact

**MPR_SCS_DCA or MPR_SCS_WATCH**

5. The SCS will determine fire boundaries based on the presented casualty.
6. The SCS will automatically establish fire boundaries where WaterMist is installed.
7. Verbally dispatch personnel where automatic fire boundaries are not established.
   
   *NOTE: Flashing magenta boundary lines represent bulkheads or decks requiring manual boundaries.*

8. Update the manual boundary state for each boundary compartment via the Compartment Context Menu. (See Section 5, “Compartment Context Menu”.)
9. Verbally dispatch personnel for manual fire attack, once a complete fire boundary is established.
10. Update the fire attack state for each fire compartment via the Compartment Context Menu. (See Section 5, Compartment Context Menu”.)
11. Update the compartment fire state when a “fire extinguished” report arrives via the Compartment Context Menu. (See Section 5, Compartment Context Menu”.)
12. The SCS will automatically reorganize the fire boundaries around the shrinking PDA until all fires have been extinguished.
13. The scenario is complete once all fires are extinguished.

Resetting Live Fire Test

**MPR_SCS_SERVER**

1. Decision Aid Module – Close application by clicking on the “X” in the upper right corner of the DAM interface.

**MPR_SCS_DCA or MPR_SCS_WATCH**

2. SCS Display - Click the “Clear Pred.”, “Clear All”, “Clear Comp.” Buttons on either of the SCS Display programs to clear all damage from the database.

**MPR_SCS_TEST**

3. Close the MassComp Interface Module by clicking on the “X” in the upper right corner of the application.
4. Close the Firemain Interface Module by clicking on the “X” in the upper right corner of the application.
5. Close the LNS DDE Server application by clicking on the “X” in the upper right corner of the application.

Shadwell PC-5
1. PreHit Interface Module – Click the “Reset Scenario/Clear Predicted Damage” button to stop the timers and remove damage from the database.
2. Close the PreHit Interface Module by clicking on the “X” in the upper right corner of the application.
TRAINING/SIMULATION

Description

Training/Simulation involves using the PreHit Interface Module (See Section 10.) and the Fire Spread Simulator Module (See Section 11) to create a hypothetical scenario useful to demonstrate the features of the SCS or to train those new to the SCS. This effort requires notification of the test team and the ship’s force.

Pre-startup procedure

i. Notify cognizant personnel before starting any portion of the SCS.
ii. Check with informed personnel regarding the state of the test area and all components controlled by the SCS.
iii. Ensure the WaterMist system is secured.

Startup Procedure

CONTROL ROOM

MPR_SCS_SERVER PC
1. Turn on the MPR_SCS_SERVER PC.

SHADWELL PC-5
2. Turn on the Shadwell PC-5.
3. Start the PreHit Interface Module by clicking the “ShadScenario.exe” icon located on the desktop.
4. PreHit Interface Module – Click “Reset Scenario/Clear Predicted Damage” button to clear any damage signals left in the database from a previous exercise.
5. PreHit Interface Module – Add a scenario by following instructions in Section 10, “Adding a Scenario” if no scenario is present.

DC CENTRAL
6. Turn on all three PCs in DCC.
7. Turn on all three video projectors.

MPR_SCS_WATCH PC
8. Start the SCS Display by clicking on the “SCS Display w/ Perf Mon” icon located on the desktop.
9. SCS Display- Login in “Training Mode” to control firemain components, “Operator Type” as “General” and click the “OK” button. This brings up the display.
   (Optional) Reorient all of the windows to properly fill all three screens.

MPR_SCS_DCA PC
10. SCS Display - Repeat steps 8 and 9 for the DCA PC located in the gray cabinet.
11. SCS Display - Click the “Clear Pred.”, “Clear All”, “Clear Comp.” Buttons on either of the SCS Display programs to clear any damage signals left in the database from a previous exercise.

**MPR_SCS_COMMS PC**

12. Start the Fire Spread Simulation Module by clicking the “DCTester” icon located on the desktop.
13. Fire Spread Simulation Module - Click OK when a window opens that says “Shadwell data source provider is FALSE”.
14. Fire Spread Simulation Module - Click the “Reset all compartment damage/Deactivate all WaterMist” button to reset all of the thermocouple and WaterMist data left in the database from a previous exercise.
15. Follow “Running a Single Point Fire” for a peacetime scenario or “Running a Mass Conflagration Fire Scenario” for a wartime scenario both found in Section 11.

**CONTROL ROOM**

**MPR_SCS_SERVER PC**

16. Start Decision Aid Module by clicking on the “Supervisory Control” icon located on the desktop.
17. Supervisory Control Program - Click “Reset all A&E” button to clear all actions and events from the displays in DCC.
18. Supervisory Control Program - Pick the first item “Ship Level Logic Module” from the drop-down list box to assign a primary function.
19. Supervisory Control Program - Click OK to start. All of the check boxes will be checked after 10 seconds.

**DAQ**

**MPR_SCS_VIDEO PC**

20. Start the PC in DAQ.
21. Start Video Server Display by clicking the “SCS Video Server” icon located on the desktop.

**Training/Simulation Procedure**

For Wartime scenario start on item 1. For Peacetime scenario skip to item 5.

**Pre Impact**

**Shadwell PC-5**

1. PreHit Interface Module – Start the scenario following the instruction in Section 10, “Running a Scenario.” The SCS will detect the hostile platform and post the information in the SCS Display’s PreHit Window.

**MPR_SCS_DCA or MPR_SCS_WATCH**

2. The SCS will post and remove “PreHit” events and actions from the Decision Aid Window in the SCS Display.
3. Follow recommended actions in Decision Aid Window. Remember to update the action status when actions are ordered and completed.
4. Skip to item 6.
Post impact

**MPR_SCS_COMMS**

5. (PEACETIME SCENARIO ONLY) - Fire Spread Simulation Module - Click “Start Scenario” to begin growing the small fire.

**MPR_SCS_DCA or MPR_SCS_WATCH**

6. The SCS will determine fire boundaries based on the presented casualty.

7. The SCS will automatically establish fire boundaries where WaterMist is installed.

8. Verbally dispatch personnel where automatic fire boundaries are not established.

   *NOTE: Flashing magenta boundary lines represent bulkheads or decks requiring manual boundaries.*

9. Update the manual boundary state for each boundary compartment via the Compartment Context Menu. (See Section 5, “Compartment Context Menu”.)

10. Verbally dispatch personnel for manual fire attack, once a complete fire boundary is established.

11. Update the fire attack state for each fire compartment via the Compartment Context Menu. (See Section 5, Compartment Context Menu”.)

12. Update the compartment fire state when a “fire extinguished” report arrives via the Compartment Context Menu. (See Section 5, Compartment Context Menu”.)

13. The SCS will automatically reorganize the fire boundaries around the shrinking PDA until all fires have been extinguished.

14. The scenario is complete once all fires are extinguished.

**Resetting Training/Simulation**

**MPR_SCS_SERVER**

1. Decision Aid Module – Close application.

**Shadwell PC-5**

2. PreHit Interface Module – Click “Reset Scenario/Clear Predicted Damage” button to remove damage from the previous simulation.

**MPR_SCS_COMMS**

3. Fire Spread Simulation Module – Click the “Stop Simulation” button.

4. Fire Spread Simulation Module – Click the “Reset All Compartment Damage/Deactivate All Water Mist” button to reset thermocouple data in the database.

**MPR_SCS_DCA or MPR_SCS_WATCH**

5. SCS Display - Click the “Clear Pred.”, “Clear All”, “Clear Comp.” Buttons on either of the SCS Display programs to clear all damage from the database.
GENERAL MONITORING

Description

General monitoring involves using the SCS system to monitor the day-to-day operations of the ship, analogous to the way the SCS would be used if installed on an active ship. The SCS is brought online and continually monitors the state of the ship, looking for abnormal conditions. This effort requires notification of the ship’s force and test team.

Pre-startup procedure

i. Notify cognizant personnel before starting any portion of the SCS.
ii. Check with informed personnel regarding the state of the test area and all components controlled by the SCS.

Startup Procedure

CONTROL ROOM

MPR_SCS_SERVER PC
1. Turn on the MPR_SCS_SERVER PC.

MPR_SCS_TEST PC
2. Start the MassComp scanning.
3. Turn on the MPR_SCS_TEST PC.
4. Start the MassComp Interface Module by clicking the “1) MassComp Interface” icon located on the desktop.
5. Start the LNS DDE Gateway Module by clicking the “2) LNS DDE Gateway” icon located on the desktop.
6. Start the Firemain Interface Module by clicking the “3) DDE Gateway” icon located on the desktop.
7. DDE Gateway Program - Change the “Network Name” to “shadwell_01_02” to connect to the SHADWELL firemain network modified on January 2002.
8. DDE Gateway Program - Click “Connect to DDE Server” button to begin the network connection process.
   The program should have a short list of nodes to connect to. Wait for this to finish. If a device cannot connect, try again. If program crashes, close application and repeat steps 4-6 again.

DC CENTRAL
9. Turn on all three PCs in DCC.
10. Turn on all three video projectors.

MPR_SCS_WATCH PC
11. Start the SCS Display by clicking on the “SCS Display w/ Perf Mon” icon located on the desktop.
12. SCS Display - Login in “Full Control Mode” to control firemain components, “Operator Type” as “General” and click the “OK” button. This brings up the display.

13. (Optional) Reorient all of the windows to properly fill all three screens.

**MPR_SCS_DCA PC**
14. SCS Display - Repeat steps 11 and 12 for the DCA PC located in the gray cabinet.
15. SCS Display - Click the “Clear Pred.”, “Clear All”, “Clear Comp.” Buttons on either of the SCS Display programs to clear any damage signals left in the database from a previous exercise.

**MPR_SCS_COMMS PC**
16. Start the Fire Spread Simulation Module by clicking the “DCTester” icon located on the desktop.
17. Fire Spread Simulation Module - Click OK when a window opens that says “Shadwell data source provider is FALSE”.
18. Fire Spread Simulation Module - Click the “Reset all compartment damage/Deactivate all WaterMist” button to reset all of the thermocouple and WaterMist data left in the database from a previous exercise.
19. Fire Spread Simulation Module – Close the application as it is not needed during general monitoring.

**CONTROL ROOM**
**MPR_SCS_SERVER PC**
20. Start Decision Aid Module by clicking on the “Supervisory Control” icon located on the desktop.
21. Supervisory Control Program - Click “Reset all A&E” button to clear all actions and events from the displays in DCC.
22. Supervisory Control Program - Pick the first item “Ship Level Logic Module” from the drop-down list box to assign a primary function.
23. Supervisory Control Program - Click OK to start. All of the check boxes will be checked after 10 seconds.

**DAQ**
**MPR_SCS_VIDEO PC**
24. Start the PC in DAQ.
25. Start Video Server Display by clicking the “SCS Video Server” icon located on the desktop.

**General Monitoring Procedure**

Once the SCS startup procedures are complete, the SCS will continually monitor the ship for changes in equipment or environmental conditions. Abnormalities will be noted in the Events column of the Decision Aid Window and graphically in the Main View Window of the SCS Display. See Section 5 for information of the SCS Display.
Resetting General Monitoring Procedure

**MPR_SCS_SERVER**
1. Decision Aid Module – Close application by clicking on the “X” in the upper right corner of the DAM interface.

**MPR_SCS_DCA or MPR_SCS_WATCH**
2. SCS Display - Click the “Clear Pred.”, “Clear All”, “Clear Comp.” Buttons on either of the SCS Display programs to clear all damage from the database.

**MPR_SCS_TEST**
3. Close the MassComp Interface Module by clicking on the “X” in the upper right corner of the application.
4. Close the Firemain Interface Module by clicking on the “X” in the upper right corner of the application.
5. Close the LNS DDE Server application by clicking on the “X” in the upper right corner of the application.
RUPTURE DEMONSTRATION

Description

Rupture demonstration involves manually initiating a firemain rupture from the control room and allowing the SCS to detect and isolate the rupture, restoring the remaining “intact” sections of the firemain. A rupture demonstration can be incorporated in a live fire test for an added degree of complexity and realism. This effort requires the full cooperation of the ship’s force and test team.

Pre-startup procedure

i. Notify cognizant personnel before starting any portion of the SCS.
ii. Check with informed personnel regarding the state of the test area and all components controlled by the SCS.

Start-up Procedures

CONTROL ROOM

MPR_SCS_SERVER PC
1. Turn on the MPR_SCS_SERVER PC.

MPR_SCS_TEST PC
2. Start the LNS DDE Gateway Module by clicking the “2) LNS DDE Gateway” icon located on the desktop.
3. Start the Firemain Interface Module by clicking the “3) DDE Gateway” icon located on the desktop.
4. DDE Gateway Program - Change the “Network Name” to “shadwell_01_02” to connect to the SHADWELL firemain network modified on January 2002.
5. DDE Gateway Program - Click “Connect to DDE Server” button to begin the network connection process.
   The program should have a short list of nodes to connect to. Wait for this to finish. If a device cannot connect, try again. If program crashes, close application and repeat steps 4-6 again.

DC CENTRAL
6. Turn on all three PCs in DCC.
7. Turn on all three video projectors.

MPR_SCS_WATCH PC
8. Start the SCS Display by clicking on the “SCS Display w/ Perf Mon” icon located on the desktop.
9. SCS Display - Login in “Full Control Mode” to control firemain components, “Operator Type” as “General” and click the “OK” button. This brings up the display.
10. (Optional) Reorient all of the windows to properly fill all three screens.
11. SCS Display - Repeat steps 8 and 9 for the DCA PC located in the gray cabinet.
12. SCS Display - Click the “Clear Pred.”, “Clear All”, “Clear Comp.” Buttons on either of the SCS Display programs to clear any damage signals left in the database from a previous exercise.

13. Start the Fire Spread Simulation Module by clicking the “DCTester” icon located on the desktop.
14. Fire Spread Simulation Module - Click OK when a window opens that says “Shadwell data source provider is FALSE”.
15. Fire Spread Simulation Module - Click the “Reset all compartment damage/Deactivate all WaterMist” button to reset all of the thermocouple and WaterMist data left in the database from a previous exercise.
16. Fire Spread Simulation Module – Close the application as it is not needed during a live exercise.

17. Start Decision Aid Module by clicking on the “Supervisory Control” icon located on the desktop.
18. Supervisory Control Program - Click “Reset all A&E” button to clear all actions and events from the displays in DCC.
19. Supervisory Control Program - Pick the first item “Ship Level Logic Module” from the drop-down list box to assign a primary function.
20. Supervisory Control Program - Click OK to start. All of the check boxes will be checked after 10 seconds.

21. Start Video Server Display by clicking the “SCS Video Server” icon located on the desktop.
22. Start the PC in DAQ.

Rupture Procedure

1. Select the firemain system view in the SCS Display for easy viewing of the SCS firemain rupture isolation.
2. Start a fire pump manually or through the SCS by clicking on a pump icon and confirming the pump start.
3. Allow firemain to reach operating pressure.
4. Ensure all Remote Manual and Smart Valves are open.
5. Open the selected rupture path by toggling the desired rupture path activation switch on the ship’s control console of the Control Room.
6. The SCS will post a rupture detection message identifying the rupture location in the Decision Aid Window.
7. The SCS will automatically detect and isolate the rupture location restoring firemain pressure to the remaining in-tact sections.
8. The SCS will post a successful rupture isolation message identifying the rupture location and clear the rupture detection message in the Decision Aid Window.

**Resetting the Rupture Demo**

1. Secure the selected rupture path by toggling the proper rupture path activation switch on the back console of the Control Room.
2. Open the Smart Valves which closed to isolate the rupture. Note: Based on the leak-by of some Smart Valves, they may reopen automatically once the previously ruptured piping segment repressurizes.
3. The SCS is ready to run another rupture scenario or to secure the SCS.

**MPR_SCS_SERVER**
4. Decision Aid Module – Close application by clicking on the “X” in the upper right corner of the DAM interface.

**MPR_SCS_TEST**
5. Close the Firemain Interface Module by clicking on the “X” in the upper right corner of the application.
6. Close the LNS DDE Server application by clicking on the “X” in the upper right corner of the application.
The follow is a list of functional capabilities as of February 22, 2002:

- Identification of the Primary Damage Area (PDA) for both “wartime” casualties using functioning and damaged sensors.
- Detection of small “peacetime” fires using Early Warning Fire Detection System.
- Automatically define fire boundaries.
- Automatically establish and maintain fire boundaries using the installed WaterMist system where available.
- Automatically detect and isolate piping ruptures in the ex-USS SHADWELL’s firemain.
- Dynamically generated “Decision Aid” message posting for required manual actions.
- Track Door Status.
- Resource management.
- Task prioritization and scheduling.
- PreHit Interface with existing Combat Systems computers.
- Fire growth simulation.
- Real-time scenario extrapolation to predict and minimize ship damage.
- Crew training in live fire or simulated environments for “wartime” and “peacetime” casualties.
LOCATIONS

The SCS Display is currently located on:
- MPR_SCS_DCA in Damage Control Central (DCC),
- MPR_SCS_WATCH in DCC and
- MPR_SCS_REP2 in Repair Locker 2

PURPOSE

The SCS Display is the operator’s view of the SCS. (See Figure 5-1.) All the information processed by the SCS and contained in the Common Database is presented in the display in an efficient and effective manner. The display provides situation awareness, recommendations, and a means to remotely control systems.

OVERVIEW

The SCS Display Startup Window appears at startup of application. (See Figure 5-2.) The window sets the initial display control and format properties, and automatically synchronizes the system time for display with the system time for the Common Database. The operator selects the ship from the combo box at the top of the form and the Operation Mode which regulates the operator’s control over the selected ship’s firemain system. This is necessary because of the ramifications associated with remotely controlling large equipment in a test facility. Selecting “Full Control Mode” gives the operator control of the firemain components. Pumps can be started or secured remotely and valves can be remotely opened and closed. The SCS creates a simulated firemain in “Training Mode.” The operator controls the simulated pumps and valves but actual pump and valve commands are not transmitted to the firemain components allowing the operator to train without affecting any of the operations aboard the ship.
There are three default SCS Display screen arrangements customized for specific "Operator Types". The "General" type opens the display in the ship plan view (discussed below) with testing controls for firemain rupture paths hidden from the operator. The "Test Coordinator" type opens the display in the ship plan view with testing controls for firemain rupture paths visible and accessible. The "Firemain Control" type opens the display in the firemain system oriented view (discussed below) with testing controls for firemain rupture paths hidden from the operator. The operator can switch between the ship plan fire and the firemain system oriented view after the startup screen by toggling the "FM Control" button (discussed below) on the Menu Bar.

PC time synchronization with the Common Database is automatically complete prior to the launch of the SCS Display Startup Window, but the operator can select a different PC with which to synchronize time by entering the remote PC’s name and clicking the "Synchronize Now" button.

The Session Identifier text box contains the title of the history log created during the startup process. The SCS places a default file title including the session startup date and time in the title to ensure uniqueness. The operator may overwrite the default title with a more descriptive title. Older files will be overwritten if a duplicate history log name is used.

Click the "OK" button to launch the SCS Display using the initializers from the SCS Display Startup Window or click the "Cancel" button to terminate the application.
Main View Window

Figure 5-3. SCS Display Main View

The Main View Window is the primary graphical interface for the SCS Display. (See Figure 5-3) The Menu Bar located at the top of the Main View Window contains drop-down menus and short-cut icons. The Status Bar at the bottom of the window contains the Module Status Bar and the Information Bar.

Menu Bar Icons

Zoom In. This icon zooms the main view in, focusing on the current center point of the screen. NOTE: This icon has no effect when the Firemain System View is the main view.

Zoom Out. This icon zooms the main view out, focusing on the current center point of the screen. NOTE: This icon has no effect when the Firemain System View is the main view.

Zoom Window. This icon allows the user to perform a custom zoom. When clicked the mouse pointer changes to cross-hairs and the operator can left click, hold, and drag a box.
around the desired view. The main view will then zoom and re-center to that location. NOTE: This icon has no effect when the Firemain System View is the main view.

**Zoom Home.** This icon resets the main view to the “home” view. The home view places the plan view of the entire ship in the main view. NOTE: This icon has no effect when the Firemain System View is the main view.

**Re-center View.** This icon re-centers the current main view after clicking the icon, based on where the operator left clicks in the main view. This icon has no zooming capability. NOTE: This icon has no effect when the Firemain System View is the main view.

**Show Display Options Window.** This icon launches the “Display Option Window” used to customize the main view.

**Toggle Doors.** This icon turns the door icons on and off. NOTE: This icon has no effect when the Firemain System View is the main view.

**Show System Window.** This icon launches the “show system window” which allows the operator to toggle which ship systems to overlay on the ship plan view. The firemain and WaterMist systems are currently available.

**Toggle Firemain View.** This icon toggles the main view between the ship plan view and the firemain system oriented view. This view is a functional (not geometric) representation of the firemain. Enabling the icon switches to the Firemain System View, disabling the icon reverts back to the ship plan view in the main view.

**Toggle Firemain Valve Numbers.** This icon turns the valve numbering on and off. This icon is automatically enabled if the firemain system is currently overlaid on the ship plan view or the firemain system view is shown in the main view.

**Toggle Compartment Numbers.** This icon turns the compartment numbering on and off.
**Toggle Door Numbers.** This icon turns the door numbering on and off. This icon is automatically disabled if the "Toggle Doors" icon is not enabled.

*NOTE:* This icon has no effect when the Firemain System View is the main view.

**Toggle Audio.** This icon turns the audio cues on and off.

**Show Damage Information Rapid Entry Window.** This icon launches the "Damage Information Rapid Entry" Window. This window is used to manually enter the damage states using a list of the ship's compartments and components.

**Show Component Damage Summary Window.** This icon launches the "Component Damage Summary" window, which lists all of the components that have sustained damage.

**Show Compartment Summary Window.** This icon launches the "Compartment Summary" window, which lists all of the compartments that have sustained fire, flood, smoke, blast, or fragment damage.

**Toggle PreHit Information Window.** This icon turns the "PreHit Information" window on and off. The window provides a real-time summary of current threats to the ship.

**Toggle Decision Aid Information Window.** This icon turns the "Decision Aid Information" window on and off. The window supplies the operator with prioritized situation text information and action recommendations.

**Toggle Fire Summary Window.** This icon turns the "Fire Summary" window on and off. This window plots color coded fire intensity based on overhead compartment temperature throughout the ship.

**Place Firemain in manual control mode.** This icon sets all of the automated firemain components into remote manual control mode. The operator can then control any automated
firemain component from the display. NOTE: This icon is only enabled when the firemain system is overlaid on the ship plan view or the firemain system view is selected.

Place Firemain in automatic control mode. This icon sets all of the automated firemain components into automatic control mode. The firemain components will respond reflexively to casualty conditions and CANNOT accept commands from the operator through the display. NOTE: This icon is only enabled when the firemain system is overlaid on the ship plan view or the firemain system view is selected.

Clear predicted damage. This icon clears all of the damage predicted by Combat Systems from the display and Common Database.

Clear all damage and boundaries. This icon clears all of the damage from the display and Common Database.

Clear all component damage. This icon clears all of the component damage from the display and Common Database.

Show Firemain pressure chart window. This icon launches the “Selected Instrument Readings” window, which contains key firemain instrument readings presented in a streaming chart.

Show log window. This icon launches the “Event/Action Log” window, which lists all of the key events and data points for the current evolution.

Module Status Bar
The Module Status Bar contains nine individual boxes, one box for each of the key software modules in the SCS. The boxes are shaded red or green to represent if the particular SCS software module is operating correctly. A red status box means no PC on the ship is performing the functions associated with that module. A green status box means a PC on the ship has assumed responsibility for the functions associated with that module. Using the SCS Dynamic Application Reallocation, PCs will automatically assume all of the responsibilities for the logic processing, but system interfaces for MassComp, firemain, door closure still have to be manually started and will not be reallocated if shut down.
Information Bar
The Information Bar contains data regarding the object currently under the mouse pointer when the mouse is located in the main view. The current compartment noun name and DC number will appear in the Information Bar when the mouse is hovering over a compartment. The Information Bar shows the component type and DC number when hovering over a component such as a valve, door, pipe, or pump. It is not necessary to click on a compartment or component for the information to display in the Information Bar.

Main View
Within the main view, the operator has the option to look at the Ship's Plan View or any of the system oriented views. (See Figure 5-4.) Currently, the firemain is the only system that has a dedicated system oriented view. Clicking the icon will toggle the main view between the Ship's Plan View and the Firemain System Oriented View.

Figure 5-4. Main View showing Ship's Plan View (Left) & Firemain System Oriented View (Right)

Compartments
Compartments in the Main View graphically summarize the compartment information available in the Common Database. Figure 5-5 lists the different damage states. Figure 5-6 lists the graphical representation of both horizontal and vertical fire boundaries which are overlaid on the compartment graphics. Figure 5-7 lists different fire suppression and boundary response symbology for both manual and automatic actions.
Normal Compartment
A compartment is considered normal if all functioning environmental sensors in the compartment read as expected during standard ship operations. The average overhead compartment temperature must remain below 75°C and smoke concentrations must remain below 15% obscurity at one meter.

Fire Compartment
A fire compartment has an average compartment temperature of greater than 75°C, has an eyewitness report of a fire in the compartment, or has lost all previously functioning thermocouples which could be attributed to known or suspected casualty. A fire can only be extinguished based on an eyewitness report after a thorough investigation.

Flooded Compartment
A compartment is considered flooded based only on eyewitness reports because there are currently no flooding sensors installed on the SHADWELL. A flooded compartment includes compartments that are flooded solid as well as have progressive flooding from an adjacent compartment or a significant amount of standing water on the deck. A hull penetration or fluid system leak or rupture can be causes of flooding.

Smoke-filled Compartment
Smoke-filled compartments have an average obscuration of 15% at one meter for compartments where smoke measurement equipment is installed. Currently, the second deck passageways are the only compartments on the ship outfitted with...
smoke measurement equipment. The compartment will also be reclassified as smoky if an eyewitness reports smoke, significant enough to hinder normal progress through the ship.

**Blast Damaged Compartment**
The blast damage symbol is placed in a compartment based on an eyewitness report of severe structural damage. The SCS can automatically insert the blast symbol based on known hostile threats and loss of compartment sensor data. The compartment is considered demolished. The blast damage symbol can coexist graphically with fire, flood or smoke.

**Fragment Damaged Compartment**
The fragment symbol is placed in a compartment based on an eyewitness report of minor structural damage. The SCS can automatically insert the fragment symbol based on known hostile threats and selective loss of compartment sensor data. The fragment damage symbol can coexist with fire, flood or smoke.
<table>
<thead>
<tr>
<th>Fire Boundaries RECOMMENDED</th>
<th>Fire Boundaries ORDERED</th>
<th>Fire Boundaries SET</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Horizontal Boundary Symbology</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLASHING magenta border around damage area.</td>
<td>SOLID magenta border around damage area.</td>
<td>SOLID yellow border around damage area.</td>
</tr>
<tr>
<td><strong>Vertical Boundary Symbology</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FLASHING magenta hatching on compartment deck located ABOVE the damage area.</td>
<td>SOLID magenta hatching of compartment deck located ABOVE damage area.</td>
<td>SOLID yellow hatching of compartment deck located ABOVE damage area.</td>
</tr>
<tr>
<td><strong>Significance</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The SCS recommends a boundary be established at this location but one has not been ordered nor set.</td>
<td>An order to establish a boundary at this location has been verbally issued but on-scene personnel have not reported the boundary as set.</td>
<td>The boundary is being successfully maintained. Boundary environmental conditions indicate boundary is being successfully maintained.</td>
</tr>
</tbody>
</table>

Figure 5-6. Fire Boundary Symbology
The SCS automatically determines boundary locations based on the current mission priorities, location and size of the casualty and firefighting systems installed in or around the casualty compartment(s). Boundaries will enclose the Primary Damage Area (PDA) horizontally and vertically and may include additional non-casualty compartments. The SCS may surrender a non-casualty compartment to the PDA because it has determined that compartment does not have installed automatic firefighting systems and is not worth expending manual resources to defend. Some casualties may be small enough that fire boundaries are not required.

Boundary segments between a casualty and non-casualty compartments are independent from one another. A complete fire boundary around a casualty may be comprised of recommended, ordered, and set individual boundary segments. All segments should be set ensure proper containment. The SCS will determine new fire boundaries if the SCS detects a fire on the other side of a recommended, ordered or set fire boundary and old boundaries will be surrendered. The SCS will reclaim the compartment, collapse the fire boundary, and recommend a new fire boundary to surround the now smaller casualty area if a fire is extinguished within a fire boundary.

**Recommended Boundary**
A flashing magenta boundary segment indicates a recommended fire boundary location that the SCS cannot automatically maintain using installed firefighting systems and needs to manned. The flashing boundary segment is usually coupled with a “BOUNDARIES NEEDED” event in the Decision Aid Window and a personnel dispatch message in the actions section. If the recommended boundary is not ordered and set, the fire will continue to spread. The boundary segment stops flashing when the operator orders personnel to manually maintain the fire boundary at that location. Priority should be given to vertical fire boundaries as fire spreads vertically faster than it spreads horizontally.

**Ordered Boundary**
A solid magenta boundary segment indicates an ordered fire boundary location that the SCS cannot automatically maintain using installed firefighting systems. Personnel have been dispatched to the fire boundary location but they are not in position, maintaining the fire boundary. If the ordered boundary is not set, the fire will continue to spread. The boundary segment turns yellow when the SCS receives confirmation that personnel are on scene and manually maintaining the fire boundary at that location.

**Set Boundary**
A yellow boundary segment indicates an established fire boundary location that is maintained either manually or with installed firefighting systems automatically controlled by the SCS. A set boundary should inhibit fire spread.
### Manual Actions

**Manual Fire Suppression (ManFS)**
A DC fire party has entered the fire space and is actively attacking the fire.

**Manual Boundary Cooling (ManBC)**
DC personnel are on-scene with hose, monitoring one or more of the bulkheads for hotspots. Personnel will cool the bulkheads when they feel they are too hot.

**Manual Boundary Cooling (ManBC)**
DC personnel are on-scene with hose, monitoring the deck for hotspots. Personnel will cool the deck when they feel it is too hot.

### Automated Actions

**WaterMist Fire Suppression (WMFS)**
The installed WaterMist system is actively attacking the fire.

**WaterMist Boundary Cooling (WMBC)**
The SCS is monitoring the ambient conditions in the compartment and will use the installed WaterMist system cool the compartment when compartment temperatures are too hot.

**WaterMist Boundary Cooling (WMBC)**
The SCS is monitoring the ambient conditions in the compartment and will use the installed WaterMist system cool the compartment when compartment temperatures are too hot.

---

**Figure 5-7. Fire Suppression and Boundary Response Symbology**
There are four blue icons which denote the damage control activity taking place in a compartment and are plotted by the SCS.

**Manual Fire Suppression**
The “MANFS” (Manual Fire Suppression) icon in a fire compartment informs the operator that a DC fire party (Attack Team or Rapid Response Team) are currently in the space attacking the fire. The SCS measures the overhead compartment temperature to determine the DC team’s effectiveness in attacking the fire. DC team progress cannot be measured if there are no functioning thermocouples in the compartment.

**WaterMist Fire Suppression**
The “WMFS” (WaterMist Fire Suppression) icon on top of the blue hatching in a fire compartment informs the operator that the SCS is actively using the installed WaterMist system to combat the fire. The SCS measures the overhead compartment to determine the WaterMist’s effectiveness in attacking the fire. WaterMist progress cannot be measured if there are no functioning thermocouples in the compartment. The SCS operates the WaterMist continuously when the overhead compartment temperature is above 50°C. Below 50°C the WaterMist is automatically pulsed on and off to keep the fire under control until DC personnel arrive on scene to overhaul the fire. The blue icon and hatching will be overlaid regardless of whether there is water flowing at any particular instant (i.e., pulsing). The WaterMist piping segments (shown in the WaterMist System overlay) in each compartment will denote if water is flowing into the compartment at any instant.

**Manual Boundary Cooling**
The “MANBC” (Manual Boundary Cooling) icon in a boundary compartment informs the operator that an on scene boundaryman is responsible for maintaining a fire boundary on the yellow bulkhead (horizontal boundary) or yellow cross hatched deck (vertical boundary). The SCS measures the overhead compartment temperature to determine the boundaryman’s effectiveness in maintaining the fire boundary. Their effectiveness cannot be measured if there are no functioning thermocouples in the compartment.

**WaterMist Boundary Cooling**
The “WMBC” (WaterMist Boundary Cooling) icon on top of the blue hatching in a boundary compartment informs the operator that the SCS is using the installed WaterMist system to prevent fire spread. The SCS measures the overhead compartment to determine if the WaterMist should be engaged to lower the ambient temperature. If the temperature is above 50°C the WaterMist will pulse (25%-on, 75% off) to cool the compartment while minimizing water usage. The WaterMist will remain secured if the overhead compartment temperature is less than 50°C. WaterMist progress cannot be measured if there are no functioning thermocouples in the compartment. The blue icon and hatching will be overlaid regardless of whether there is water flowing at any particular instant (i.e., pulsing). The WaterMist piping segments (shown in the WaterMist System overlay) in each compartment will denote if water is flowing into the compartment at any instant.
Compartment Context Menu

Right clicking on objects will launch customized context menus specific to the object in focus. Most compartment menus will look similar to the menu in Figure 5-8. The context menu is divided into functional groups. The operator can set and clear damage state, engage and disengage WaterMist, plot manual boundary states, plot manual fire attack, launch or hide video feeds to the video server, or request additional compartment information from the compartment context menu.

<table>
<thead>
<tr>
<th>Primary Damage:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demolished</td>
</tr>
<tr>
<td>Fragment Damage</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Secondary Damage:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark Fire</td>
</tr>
<tr>
<td>Mark Smoke</td>
</tr>
<tr>
<td>Mark Flooding</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Manned Boundaries:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended</td>
</tr>
<tr>
<td>Set</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Manned Attack:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended</td>
</tr>
<tr>
<td>Set</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Water Mist System:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Boundary Cooling</td>
</tr>
<tr>
<td>Activate Fire Suppression</td>
</tr>
<tr>
<td>Water Mist Unavailable</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Surrender Compartment</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC Actions Complete</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Compartment Detail Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Video</td>
</tr>
</tbody>
</table>

Figure 5-8. Compartment Context Menu

- **Primary and Secondary Damage items** will always appear in the context menu for all compartments. Each item in these two sections can be individually turned on or off by clicking the item in the list. A check will appear next to an item if the damage state for that compartment is true. Clicking the item again will remove the damage state from the compartment and remove the checkmark from the item.

- **Manned Boundaries and Manned Attack items** will always appear in the context menu for all compartments. These sections are exclusive. Only one checkmark can appear for the four entries because a compartment should not have a manned fire attack occurring at the same time the space is being maintained by a manual fire boundary.
• The Water Mist System items will only appear if the compartment has WaterMist sprinkling available within the compartment. These sections are exclusive. Only one checkmark can appear for the three entries. Selecting "Activate Boundary Cooling" or "Activate Fire Suppression" will turn the WaterMist system in automatic mode and will place a check next to the item selected in the context menu. Clicking the item again will secure the WaterMist in the compartment and remove the check. If one operating mode is already selected, selecting the other option from the list will activate the other mode. The check box will then appear next to the most recent selection. Selecting the "WaterMist Unavailable" item tags out the WaterMist for a particular compartment, secures the WaterMist in the compartment (if it is operating) and places a check mark next to the item in the context menu. Clicking the item again will clear the check mark and return the WaterMist functionality.

• The "Surrender Compartment" item is automatically checked if the SCS determines the compartment cannot be salvaged due to existing damage or should not be salvaged due to limited resources. The operator can also check the item to surrender a compartment the operator believes it is unworthy of saving or can uncheck the check item if the operator would like to override the SCS and save a compartment the SCS believes should not be saved.

• The "DC Actions Complete" item remains disabled if there is no primary or secondary damage in the compartment. If there is damage, this item is used to clear all of the primary and secondary damage with one entry. This item can be used if the SCS has assumed damage or fire spread but an on-scene investigator has verified there is no damage in the compartment. Clicking this item will remove all of the checks in the Primary Damage and Secondary Damage sections of the context menu and remove all of the damage overlays for the compartment in the Main View.

• The "Compartment Detail Information" item launches a window that provides more compartment information than can be displayed graphically in the Main View (See Figure 5-9). The top of the Compartment Detail Information Window displays the compartment number and compartment noun-name. The next two rows summarizes the primary and secondary damage states and average compartment temperature based on installed thermocouple readings and the fire severity (small, medium, large, fully involved). The fourth row summarizes the fire boundary state for the compartment. The “Components Located in the Compartment” section lists all of the ship’s assets which are located in the compartment. The component DC number, classification, status/position and condition are summarized for each component in the list. The “Compartment Instrumentation” section lists all of the sensors located in the compartment, model, sensor type, current reading, sensor reading report time, and the data acquisition channel the sensor is wired to. The data in the sensor list refreshes automatically while, the rest of the information in the window does not. The window must be closed and reopened for other information in the window to refresh.
The "Show Video" item will only appear in the context menu if the compartment has video cameras installed within the compartment. If the item is checked the compartment's video cameras will automatically appear on the SCS Video Server application. The operator can add a particular compartment's video to the Video Server rotation by clicking the item in the context menu. The operator can also remove a video from the Video Server rotation by clicking the checked item in the context menu. See Section 7 for more information about the Video Server.

Components
The operator can execute the majority of actions directly from the main view with either the Ship's Plan View or Firemain System Oriented View displayed. Left clicking on components can initiate an action. Remote manual or Smart Valves can be opened and closed by left clicking on the valve body graphic. Remote manual pumps can be started by left clicking on the pump graphic, then confirming the operation in a follow-up message box. See Figure 5-10 for complete list of components included in the SCS.
Manually Operated Valves
Currently there are six manually operated valves in the SHADWELL firemain located in the test area (frames 15-29). These valves have no motor operators and no communication with the SCS therefore the SCS can not determine the position of these valves and these valves should be left in their default position if possible. This allows the SCS to better determine the configuration and operating state of the firemain, including rupture detection and realignment schemes. See Figures 5-10, 5-11 and 5-12 for information regarding valve symbology.

Remote Manual Valves
Currently there are nine remote manual valves in the SHADWELL firemain located in the test area (frames 15-29). These valves have an electric motor operator and communication with the SCS. The SCS continually monitors the position of these valves to determine the configuration and operating state of the firemain, including rupture detection and realignment schemes. See Figures 5-10, 5-11 and 5-12 for information regarding valve symbology.

Smart Valves
Currently there are five Smart Valves in the SHADWELL firemain located in the test area (frames 15-29). These valves have an electric motor, onboard pressure sensors and communication with the SCS. The SCS monitors the fluid characteristics from...
each of the Smart Valves [4] and the position of all the valves in the firemain, and operating states of the fire pumps in real time to determine if there is a rupture.

The Smart Valves also have the capability to individually determine if there is a rupture and should close, without the assistance of the SCS. This allows the Smart Valves to operate even if network communication to the SCS is severed during a casualty. This capability is documented in Reference 4. See Figures 5-10, 5-11 and 5-12 for information regarding valve symbology.

Remote Manual Pump
There are two remote manual pumps installed on the SHADWELL responsible for pressurizing the firemain. The pumps can be started and stopped from the SCS but the pump’s operating speed can only be controlled from the frequency drive located near the individual pumps. The SCS displays each pump’s current operating speed, suction and discharge pressures. See Figures 5-13 and 5-14 for information regarding pump symbology.

Fireplug
There are nine fireplugs installed in the SHADWELL firemain located in the test area (frames 15-29). These fireplugs do not have any communication with the SCS. Their fluid status (pressurized/unpressurized) is derived from the firemain valve and pump alignment. See Figures 5-15 and 5-16 for information regarding fireplug symbology.

Pipe Segment
An individual pipe segment for the SCS is defined as a run of pipe bounded on either end by a bulkhead, deck, valve, pump, fireplug or pipe junction. Pipe segments do not have instrumentation. Their fluid status is derived from valve and pump alignments. See Figures 5-17 and 5-18 for information regarding pipe symbology.
Valve with no pressure or flow from either fire pump.

Valve with fluid pressure and flow supplied from the port side fire pump.

Valve with fluid pressure and flow supplied from the starboard side fire pump.

Valve with fluid pressure and flow supplied from both the port and starboard side fire pumps.

Valve with fluid characteristics that suggests a local fluid rupture.

**Figure 5-11. Valve States**

![Normal Valve](image1) ![Degraded Valve](image2)

Normal Valve
Valve with maximum functional capability.

Degraded Valve
Valve with diminished functional capability.

![Valve Out of Commission (OOC)](image3) ![Valve Error](image4)

Valve Out of Commission (OOC)
Valve with no functional capability.

Valve Error
Valve has lost communication with SCS. Status is unknown.
(Remote manual or Smart Valves only)

**Figure 5-12. Valve Damage States**

NOTE: Valves in Figure 5-12 are shown in white (unpressurized/isolated) but symbology can exist with any color (white, orange, green, purple, red) valve.
Open Valve
Bowtie ends are in-line with piping.
NOTE: White (unpressurized/isolated) piping shown. Open valve will assume the color of the surrounding piping (green, orange, purple, red, white).

Closed Valve
Bowtie ends are not in-line with piping.

SPECIAL SITUATIONS

Closed Valve
Valve is SEGREGATING the firemain into two halves.
NOTE: Green (starboard pump supplied) piping on one side and orange (port pump supplied) piping on the other.

Closed Valve
Valve is ISOLATING a section of the fluid system.
NOTE: Green (starboard pump supplied) piping on one side and white (isolated) piping on the other.

NOTE: A closed valve will always be white (isolated) regardless of the surrounding piping color (white, orange, green, purple, red).

Figure 5-13. Valve Position
Secured Fire Pump (Either port or starboard)  
Operating Fire Pump (Starboard Side Pump)  
Operating Fire Pump (Port Side Pump)

Figure 5-14. Pump States

Normal Pump  
Pump with maximum functional capability.

Degraded Pump  
Pump with diminished functional capability.

Pump OOC  
Pump with no functional capability.

Pump Error  
Pump has lost communication with SCS. Status is unknown.

NOTE: Pumps in Figure 5-15 are shown in white (secured) but symbology can exist with any color (white, orange, green) pump.

Figure 5-15. Pump Damaged States
Fireplug with no pressure or flow from either fire pump.

Fireplug with fluid pressure and flow supplied from the port side fire pump.

Fireplug with fluid pressure and flow supplied from the starboard side fire pump.

Fireplug with fluid pressure and flow supplied from both the port and starboard side fire pumps.

Fireplug with fluid characteristics that suggests a local fluid rupture.

**Figure 5-16. Fireplug States**

Normal Fireplug
Fireplug with maximum functional capability.

Degraded Fireplug
Fireplug with diminished functional capability.

Fireplug OOC
Fireplug with no functional capability.

NOTE: Fireplugs in Figure 5-17 are shown in white (unpressurized/isolated) but symbology can exist with any color (white, orange, green, purple, red) fireplug.

**Figure 5-17. Fireplug Damage States**
Firemain or WaterMist system pipe segment with no pressure or flow from a pump.

Firemain pipe segment with fluid pressure and flow supplied from the port side fire pump.

Firemain pipe segment with fluid pressure and flow supplied from the starboard side fire pump.

Firemain piping segment with fluid pressure and flow supplied from both the port and starboard side fire pumps.

WaterMist pipe segment with fluid pressure and flow supplied from the WaterMist pump.

Firemain OR WaterMist pipe segment with fluid characteristics that suggests a local fluid rupture.

Figure 5-18 Firemain Piping States

Normal Piping Segment
Piping segment with maximum functional capability

Degraded Piping Segment
Piping segment with diminished functional capability.

Piping Segment OOC
Piping segment with no functional capability.

NOTE: Piping segments in Figure 5-19 are shown in white (unpressurized/isolated) but symbology can exist with any color firemain (white, orange, green, purple, red) pipe segment. This symbology does not exist for WaterMist (light blue, white or red) pipe segments.

Figure 5-19. Firemain Piping Damaged States
Component Context Menu
Right clicking on objects will launch customized context menus specific to the object in focus. Component menus will look similar to the menu in Figure 5-20.

![Figure 5-20. Component Context Menus: Generic Menu (Left), Motor Operated Valve Menu (Center), and Pump Menu (Right)](image)

- Damage plotting is common to all component context menus. The first two items are used to plot a degraded (“Flag as Degraded”) and/or out of commission (“Flag as OOC”). These two damage states are not exclusive and can coexist. Click on the context menu item to set a component state. A check mark will appear next to the item selected. Select the item again to remove component state and remove the check mark.
- The next item common to all component context menus is the component information window. The “Component Info”, “Valve Info”, or “Pump Info” items launch a window that provides more component information than can be displayed graphically in the Main View. A Pipe Detailed Information Window is shown in Figure 5-21. The component detailed information window provides the DC Number, component type (such as valve, pump, door), parent system, compartment location (DC number and noun-name), current operability status, and current damage status. The data in the window is static. The window must be closed and reopened for information in the window to refresh.
Decision Aid Window

The SCS Decision Aid Window supplies the operator with prioritized situational text information. (See Figure 5-22.) This window can be accessed by clicking the DA icon, by selecting "View→Alarms/Events & Suggested Actions" from the main view menu bar or by pressing CTRL+D on the keyboard.
The left-hand pane in the window summarizes key events sorted and color-coded by severity. The most important messages are at the top of the list in the darker shades of red while the least important messages appear at the bottom of the list in yellow. Each posted event has a post time to notify the operator when the event appeared in the list. There is an acknowledged event icon to distinguish events the operator has already read versus a new event, which the operator has not seen. New events have a dot next to the time reported column, acknowledged events do not have a dot.

Events can be filtered using the drop down list box located at the top of the event list. Currently, there are two distinct users: “DCA” and “Systems Operator”. The “DCA” filter removes events related to fluid system damage and reconfiguration, while displaying events focused around high-level casualty management (boundaries, fires, flooding and smoke). The “Systems Operator” filter removes events focused around high-level casualty management while focusing on fluid system damage and recoverability efforts. There is an “All Operators” filter which does not do any filtering, showing all events to the operator.

The right-hand pane in the Decision Aid Window lists recommended human actions presented by the SCS. The recommended actions are listed on the left side of the actions pane. The two right columns track the recommended action’s status. Actions only appear in the actions pane when the user selects an event from the event pane on the left that contains actions. If there are no recommended actions for an event, nothing will appear in the actions pane. The operator can choose to execute an SCS recommended action or ignore the action. If the recommended action is ordered, the operator should click the “Ordered” button, implying the action has been ordered but not complete. At this time the button text changes from “Ordered” to “Complete.” When the operator gets word the ordered action has been completed, the “Complete” button should be clicked for the appropriate action. Once the “Complete” button has been clicked the action is automatically removed from the action list for that appropriate event. If the operator chooses not to execute the recommended action, the operator can click the “Ignore” button, which removes the action from the list. If the SCS decides the situation has changed enough to re-suggest the
The same action may be posted in the action list again at a later time. The same action may appear in the action list for different events suggesting the same action be taken multiple times. In this case each action is treated independently and tracked separately. SCS recommended actions are automatically removed from the action list for any given event if the situation changes to where the recommended action is no longer appropriate.

The “Show Completed” button at the top of the actions pane toggles the event and actions pane to show all of the completed actions (but not ignored actions) and the events to which they were tied. Clicking the button again reverts back to the pending (default) events and actions pane.

The “Print Actions” button prints the actions for any given event that are currently shown in the actions pane of the Decision Aid Window.

Actions can be filtered using the drop down list box located at the top of the action list. Currently there are four setting: “DCA”, “Systems Operator”, “All Operators” and “All Actions”. The “DCA” filter removes actions related to fluid system damage and reconfiguration, while displaying actions focused around high-level casualty management (boundaries, fire, flooding and smoke). The “Systems Operator” filter removes actions focused around high-level casualty management while focusing on fluid system damage and recoverability efforts. The “All Operators” filter which does not do any filtering, showing all actions to the operator. The previous three setting only show the action related to the highlighted event in the event pane. The “All Actions” setting shows all actions for all of the events in the event pane regardless of the event that is currently selected.

PreHit Window

The PreHit Window simulates a connection with the Combat Systems computers on the ship. (See Figure 5-23.) The purpose of this window is to provide a real-time summary of current threats to the ship. Currently the PreHit Window is fed information from the Scenario Generator (see below) via the Common Database (see below). This window can be accessed by clicking the icon or by selecting “View→Pre-Hit Info” from the main view menu bar.

During normal operation the situation summary will say “No Hostile Platforms” on a gray background and the bogey description will be blank.
When a bogey is detected, the combat systems situation summary turns yellow and notes, “Hostile Platform Detected.” A bogey description appears below summarizing the warhead size, impact side and time to impact if a missile has been launched, time to enter strike range and attack status if a missile has not been launched.

If the bogey is within its strike range, the combat systems summary will turn orange noting the bogey’s weapons are capable of reaching the ship. If a missile has been launched, the summary turns red noting, “Incoming Threat.” The estimated time to impact is also tracked.

The “Zoom Hitpoint” button will recenter the main ship view around the projected hitpoint location and surrounding compartments, when a bogey is present and the impact location of the bogey’s inbound weapon is known. This feature does not function while in the Firemain System View.

The “Show Details” button provides a more thorough description of the bogey that is available in the bogey description. Currently, there is no descriptive information shown by clicking the “Show Details” button. This could be used to implement software and itself would predict weapons effect data.

If the PreHit Window is not visible when a bogey is detected, the window will appear with the most current information from Combat Systems. If the window is closed using the “X” button in the upper right corner the window will reappear. If the operator clicks the “Hide Me” button the window will disappear and will not reappear regardless of the state of the bogey.

**Plan View Window**
The Plan View Window can be accessed by selecting “View→Plan Locator” from the main view menu bar or by CTRL+P on the keyboard. (See Figure 5-24.)
The Plan View Window has a dual purpose. Its primary purpose is for resizing the main view. Clicking and holding the left mouse button, while dragging a box around the desired region sets the main view. Simply clicking the left mouse button without dragging a box zooms into a single compartment view.

The Plan View Window plots identically to the main view. Any coloration displayed on the main view will be displayed in the Plan View Window. This allows the operator to keep a "big picture" of the casualty while the main view may be focused on a smaller subsection of the ship.

Profile View Window
Selecting "View Profile Locator" from the main view menu bar will access the Profile View Window. (See Figure 5-25.)
The Profile View Window summarizes all of the damage per deck between any two adjacent watertight subdivisions. When there is fire, flood, or smoke in a compartment, the white box corresponding to the appropriate deck and subdivision turns red signifying a problem in that location. The operator can click in any white or red rectangle and the main view will refocus, centered on the corresponding deck and watertight subdivision.

The “Zoom Test Area” button will refocus the Profile View Window to feature the forward portion of the ship. The “Zoom Ship” button will refocus the Profile View Window to feature the entire ship in the window.

Fire Summary Window

The Fire Summary Window can be accessed by clicking the icon, selecting “View—Fire Summary Bar” from the main view menu bar, or by CTRL+S on the keyboard. (See Figure 5-26.)
The Fire Summary Window plots fire intensity based on temperature. Compartments containing small fires are shown in yellow, medium size fires are orange, large fires are red. Black compartments represent spaces where all thermocouples are damaged and large fires are assumed. The PDA is an example of an area that would appear black because thermocouples in the space would not be expected to survive.

Compartment Information Window

The Compartment Information Window can be accessed by selecting “View→Compartment Summary Bar” from the main view menu bar or by CTRL+M on the keyboard. (See Figure 5-27.)
The Compartment Information Window summarizes key information regarding the last compartment clicked in the main view. Casualty text information, such as average compartment temperature, temperature growth rate, fire, flood, and/or smoke, is present in the upper half of the Compartment Summary Bar. The lower half of the window summarizes the information using Navy standard icons. Information is automatically updated when a new compartment is selected from the main view. The “Get Update Now” button gets the current information for the already selected compartment. Clicking repeatedly on the same compartment in the main view will not continually update the information in the Compartment Information Window.

**Video Bar Window**
The Video Bar Window can be accessed by selecting “View→Video Bar” from the main view menu bar or by CTRL+X on the keyboard. (See Figure 5-28.)
The Video Bar Window provides real-time streaming video feeds from compartments throughout the ship. To view video, enter the IP address of the Indigo Codex containing the camera you wish to view. Select one of the five cameras connected to the Indigo Codex, and click “Start Video.” Select the “Stop Video” button to stop the video feed. The video will appear in the video display window of the Video Bar Window. The video quality automatically adjusts based on available network bandwidth and CPU load.

**NOTE:** Two operators cannot view video fed from two different cameras from the same Indigo Codex box at the same time. If this occurs, one or both videos will cease to function until one operator selects another video. This is a limitation in the Indigo Codex hardware. This conflict also exists with videos shown in the SCS Video Server described below.

**Damage Information Rapid Entry Window**

The “Damage Information Rapid Entry” Window can be accessed by clicking the icon, selecting “Utilities—Quick Damage Entry”, or Ctrl + Q. (See Figure 5-28.) The window is used to quickly plot damage to multiple compartments and components from one location. To enter damage, select the tab for the type of damage (component or compartment damage). Select the components or compartments from the list or enter a DC Number in the “Search Key” box to quickly scroll to a compartment or component. Once an item has been selected, choose a damage status using the “Damage Status” radio buttons, then click the “Apply Now” button. Selecting the “Goto” button when a component or compartment is selected refocuses and zooms the main view around the component or compartment.
Compartment Damage Summary Window

The “Compartment Damage Summary” Window can be accessed by clicking the icon or by selecting “Utilities→Compartment Damage Summary”. (See Figure 5-30.) The window is used to quickly provide a summary of damage compartments on the ship. The window will be empty when there are no damaged compartments. The DC Number for the compartment will appear in the list in the left column if there is any type of compartment damage. A “Yes” will appear in the column for the appropriate type of damage, such as fire, flood and smoke. Highlighting a compartment entry and clicking the “Goto” button will refocus and zoom the main view around the compartment selected.

Figure 5-30. Compartment Damage Summary Window
Component Damage Summary Window

The “Component Damage Summary” Window can be accessed by clicking the icon or by selecting “Utilities → Component Damage Summary”. (See Figure 5-31.) The window is used to quickly provide a summary of damage components on the ship. The window will be empty when there are no damaged components. The DC Number for the component along with the type of component, current operating state, location, name, and damage state will be listed if there are any damaged components. Highlighting a component entry and clicking the “Goto” button will refocus and zoom the main view around the component selected.

![Component Damage Summary Window](image)

**Figure 5-31. Component Damage Summary Window**

Selected Instrument Readings Window

The “Selected Instrument Readings” Window can be accessed by clicking the icon. (See Figure 5-32.) The window is used to graphically show key firemain sensor readings in a strip chart format. Data from the port and starboard firemain pressure sensors and both firemain suction and discharge pressures are scrolled across the screen in real-time.
The “Event/Action Log” Window can be accessed by clicking the icon. (See Figure 5-33.) The window summarizes the key events reported and actions taken and is a text-based history of the current evolution. The “Clear Log” menu option deletes the current log with the option to save the information to a text file. The name of the text file is defined on the login screen and is usually a function of the date and time the particular session was started. Selecting “Dump Log” deletes the log entry without the option to save.

NOTE: The Event/Action Log is saved to the text file by default when the program is shut down, so there is no need to visit this screen to save the log before shutting down.
Display Options Window

The “Display Options” Window can be accessed by clicking the icon, by selecting “View→ Display Options” or CTRL+Shift+O. (See Figure 5-34.) The window customizes the appearance of the Main View. The “System Visibility” section allows the operator to overlay various ship systems on the ship’s plan view in the main view. Multiple systems can be overlaid simultaneously. This section is identical to the functionality of the “Set System Visibility” Window. The operator can set the visibility of compartments, compartment numbering, access, and access numbering via the “Compartment & Access Display Options” section. One of the three radio buttons may be selected and any combination of the three check boxes can be selected. The “System Display Options” section is enabled when the firemain system piping is overlaid on the ship plan view. The operator can enable component labels, vertical pipe run lines, and vertical pipe run continuity arrows for the piping between decks. Clicking the “Ok” or “Apply” buttons will apply the changes to the view. The “Cancel” button will revert to the previously saved display options.
Figure 5-34. Display Options Window

Set System Visibility Window
The “Set System Visibility” Window can be accessed by clicking the icon or by selecting “View→Set System Visibility”. (See Figure 5-35.) This window allows the operator to overlay various ship systems on the ship’s plan view in the main view. Multiple systems can be overlaid simultaneously. This section is identical to the functionality of the “System Visibility” group in the “Display Options Window”. Unchecking a box will remove the system overlay from the ship’s plan view in the main view.

Figure 5-35. Set System Visibility Window
Operational Priorities Window
The “Operational Priorities” Window can be accessed by selecting “Mission & Operational
Priorities→ Define Operational Priorities”. (See Figure 5-36.) The window sets the generalized
ship’s standing orders. They are organized into four general categories. The relationship of each
priority’s value to each other determines how the SCS will respond to casualties. Adjusting the
operational priority values during a casualty will cause the system to reevaluate the current
course of action and possibly change the fire boundaries and resource allocation for maximum
efficiency based on the newly selected operational priority values.

![Figure 5-36. Operational Priorities Window](image-url)
Communications Plotter Display

Figure 6-1. SCS Communications Plotter Display.

LOCATION

Starboard computer console in DCC.

PURPOSE

The Communications Plotter Display is used to enter data relevant to the casualty communicated over wire free communications (WIFCOMM). The Communications Officer monitors the internal damage control channel, in communication with on-scene investigators, and supplements the SCS information with relevant verbal information. Reporting of jammed doors, extinguished fires or structural damage are reports that cannot be detected by SCS sensors but are useful in SCS decision processing. The Communications Officer uses the Communication Plotter Display to deconstruct the verbal report into useful data for the SCS to consider while processing.
OVERVIEW

The Communications Plotter Display interface is divided into seven functional panels. (See Figure 6-1.) The Communications Plotter Display interface was designed to follow the standard diction for message delivery working from left to right.

Message Management Bar (Top)

The operator clicks the “New Incoming Message” button to initiate a new entry. The entry can be cancelled at any time by clicking the “Cancel Report” button. Clicking the “Exit” button closes the application. The current date and time is posted at the far right of the Message Management Bar.

Report Source Pane (Middle, Left)

The Report Source Pane lists the possible origins of an incoming message. There are five discrete personnel types (Attack Team Leader, Boundaryman, Data Taker, Investigator and Scene Leader), a catchall “Anybody,” for those who do not fit in a discrete category and the option for input based on a video observation. Click on the type of person relaying the message to DCC.

Compartment Pane (Middle, Left-Center)

The operator selects the subject compartment by typing the DC number into the text box of the Compartment Pane using the key pad, the keyboard or by selecting it from the list box. The list of compartments in the list box gets shorter as the operator enters more of the compartment DC number into the text box, helping to narrow the search. The operator can select a compartment from the list box at anytime while typing in the text box. The list box will be empty if the operator types a DC number that does not correspond to a compartment on the ship.

Damage Report Type Pane (Middle, Right-Center)

The operator selects the subject of the message from the Damage Report Type Pane. There are seven damage categories: Fire, Fire Boundaries, Smoke, Flood, Structural, Personnel Casualties and WaterMist Availability. Selecting the Damage Report Type populates the Damage Report Details Pane (see below) with more specific information to accurately translate the message to the SCS.

Damage Report Details Pane (Middle, Right)

The Damage Report Details Pane provides a subset of options based on the message category selected in the Damage Report Type Pane. Selecting a different damage report type will update the Damage Report Details Pane with different message details to select.

Ship View Pane (Bottom, Left)

The Ship View Pane shares the same symbology as the Ship Plan View in the Main View of the SCS Display discussed in Section 5. The Ship View Pane automatically zooms toward the compartment entered in the Compartment Pane text box as more of the compartment DC number
is provided in the box. The Ship View Pane can also be used to select the compartment in the Compartment Pane by double clicking the compartment graphic, if a compartment has not already been selected in the Compartment Pane. Another compartment may be selected using the Ship View Pane if the selected compartment is cleared from the Compartment Pane text box.

**Current Report Info Pane (Bottom, Right)**

The Current Report Info Pane summarizes all of the information entered for a particular message so the operator can review the information before it is submitted to the SCS. The information is listed with the date and time the message was started. Incorrect information can be corrected by changing any selection above. Click the “Enter Report” button to submit the information to the SCS. Another report for the same compartment can be immediately started without reselecting the compartment because a number of useful pieces of information about the same compartment tend to be relayed consecutively. Click “Finished W/ Compartment” button to completely reset the data entry screen if the next message deals with a different compartment.

**OPERATION**

1. Click the “New Incoming Message” button to initiate a new message entry.
2. Select the report source from the Report Source Pane.
3. Enter the subject compartment using the key pad, keyboard, list box, or Ship View Pane.
4. Select a damage report type from the Damage Report Type Pane.
5. Select the specific damage from the Damage Report Details Pane. If the damage relates to components (i.e., doors) select the specific doors from the Ship View Pane after selecting the damage state from the Damage Report Details Pane.
6. Review the information before it is submitted to the SCS.
7. Click the “Enter Report” button to submit the information to the SCS.
8. Start another message for the same compartment or click the “Finished W/ Compartment” button to reset the data entry screen if the next message relates to a different compartment.
Video Server Display

LOCATION

Display – Port video projector in DCC.
Processor – In the Data Acquisition (DAQ) Closet (Node Room #1).

PURPOSE

The Video Server Display is designed to manage the live video streams from cameras located throughout the ship. (See Figure 7-1.) The display has the capability to show five (5) simultaneous videos. There is a video hardware limitation of displaying one camera at a time from each of the distributed video collection boxes. The videos are posted along with a summary of relevant information. The video server selects key videos for the operator to see and the operator can add or remove any video. The operator has no user interface for this display but remotely controls the videos through the Compartment Context Menu for each compartment in the SCS Display. (See Section 5, SCS Display, “Compartment Context Menu” for more information.)
OVERVIEW

The SCS Video Server is divided into six panes, three across the top and three across the bottom. The last pane on the bottom, right shows the time and is not capable of showing video. Each of the remaining five panes automatically shows live streaming video when there are casualty conditions in the space or when the operator selects a specific compartment video from the Compartment Context Menu of the SCS Display. Figure 7-2 shows the anatomy of a single video pane. The location of the video camera consisting of compartment DC number and noun name is presented in the menu bar. The center of the video pane contains the live streaming video from the compartment. The screen may remain black if the video camera is damaged or destroyed or if there is excessive network traffic. Below the video is text signifying the reason the video is shown. The following reasons are:

- DCA Requested,
- Fire,
- Flood,
- Smoke,
- Early Warning Alert,
- Horizontal Boundary – WaterMist Protection Requested,
- Horizontal Boundary – WaterMist Protection Enabled,
- Horizontal Boundary - Manual Boundary Set,
- Horizontal Boundary - Manual Boundary Enroute,
- Horizontal Boundary - NOT MAINTAINED,
- Vertical Boundary – WaterMist Protection Requested,
- Vertical Boundary – WaterMist Protection Enabled,
- Vertical Boundary - Manual Boundary Set,
- Vertical Boundary - Manual Boundary Enroute,
- Vertical Boundary - NOT MAINTAINED,
- Horizontal and Vertical Boundary – WaterMist Protection Requested,
- Horizontal and Vertical Boundary – WaterMist Protection Enabled,
- Horizontal and Vertical Boundary - Manual Boundary Set,
- Horizontal and Vertical Boundary - Manual Boundary Enroute or
- Horizontal and Vertical Boundary - NOT MAINTAINED.

The second row under the video, displays the current overhead temperature for the compartment. The temperature will read -1000°C if all of the thermocouples in the compartment are not functioning. This may be due to physical damage to the sensors in the compartment or wiring trouble to the data collection unit.
There will be no video panes visible during normal ship operation unless the operator specifically requests to see a video. One or more video panes automatically appear after a casualty has been detected. Video panes disappear when the cause for the video to appear is gone. The five panes scroll through the required videos devoting ten seconds to each video if more than five videos are selected. Compartment information (compartment DC number, compartment noun-name and current temperature) will scroll with the proper video feed. This allows the operator to see more than five video feeds without taxing the CPU responsible for displaying the videos.

**OPERATION**

See Section 5, SCS Display, “Compartment Context Menu” for information regarding adding or removing video from the SCS Video Server.

Displaying a video can take up to one minute from the time an operator selects a video or the systems determines a video should be displayed until the video appears on the screen. This is caused by the video acquisition hardware distributed throughout the ship and is not a function of the SCS or the PCs on which the SCS is operating.

Videos will appear at SCS startup tagged as “DCA Requested” if the SCS operator has left videos selected from a previous evolution. See Section 5, SCS Display, “Compartment Context Menu” for information regarding removing these videos from the SCS Video Server.
8 Decision Aid Module

Figure 8-1. Decision Aid Module

LOCATION

MPR_SCS_SERVER located in the Control Room.

PURPOSE

The Decision Aid Module (DAM) is the core behind the SCS and contains all of the SCS software modules required to process all of the raw data. (See Figure 8-1.) The DAM loads only the software modules required, based on the module assignment of the DAM and the other functioning DAMs aboard the ship. For day to day operations aboard the ex-USS SHADWELL only one DAM is operated handling all of the information processing for the SCS.

OVERVIEW

The DAM contains a complete set of code capable of processing all of the raw data in the Common Database. The DAM software is segregated along function lines into software modules containing the code required to process information for a particular type of object, listed as follows:

- Compartments
- Zones (Interaction of compartments within watertight subdivisions)
- Components (valves, pumps, sensors)
- Systems (Interaction of components with a system: Firemain, WaterMist)
- Ship (Interaction of all zones and systems)

A complete set of DAM software modules exist at each location. One or more of the DAM software modules can be operating at any location. Each DAM monitors the number of processing entities (i.e. individual compartments and zones) across all of the stations running the DAM and loads only the software modules for designated entities that are not monitored in other locations. The DAM will load software modules for systems or entities, which are already monitored elsewhere, and cause remote DAM stations to offload the same responsibility for a particular system or entity in an effort to evenly distribute processing load across all of the available DAM PCs. A module will automatically assume responsibility and load a new module if a remote PC, initially responsible for a particular system or entity, is secured or destroyed, ensuring all of the systems and entities are being monitored at only one location without unnecessary duplication in processing.

The Ship, Firemain, and WaterMist DAM software modules are each responsible for one process, managing the ship, the firemain system and the WaterMist system respectively. These modules are loaded and executing on only one PC at a time. The Compartment and Zone DAM Software Modules can be loaded and executing on more than one PC at a time, but only one PC on the ship is responsible for processing each individual compartment or zone using the Compartment and Zone DAM Software Modules.

Each instance of the DAM Software Module is assigned a primary function at startup. Assigning a primary function helps manage which instance of the DAM has priority over a specific system or entity, minimizing confusion and duplication of effort between the modules. A DAM will always process information pertaining to its primary function. As mentioned above, another DAM will automatically assume responsibility and load a new module if a remote PC, initially responsible for a particular system or entity, is secured or destroyed. The DAM’s primary function of the secured or destroyed PC will be reassigned to another DAM as a non-primary function; the responsibility will be assumed by the PC with the lowest processor load.

The “Dynamically Loaded DDLs” frame on the user interface shows the user the DAM software modules currently running on the local PC. There are five discrete DAM software modules: Ship, Zone, Compartment, Firemain and WaterMist. The check box is checked if the respective DAM software module is loaded into memory and is currently executing.

The remaining frames on the interface show the status of the system software modules (Firemain and WaterMist), the individual software modules (zones one through four) and all of the compartments monitored by the SCS, grouped according to the respective zone. The check box is checked if the respective system or entity is monitored by this DAM.
Startup

1. Start "Supervisory Control" program by double clicking on the "Supervisory Control" icon on the SCSSERVER_PC. The "Supervisory Control Primary Module Selection" window will appear. (See Figure 8-2.)
2. Select the primary function for the DAM from the drop-down list box, which contains a listing of all of the systems, zones and compartments on the ship.
3. Click the "Reset A&E" button (Actions & Events) if this is a new scenario or demonstration.
4. Click the "OK" button to complete the startup process. The DAM will determine which systems or entities to monitor in addition to its assigned primary function. The DAM user interface will appear and with the appropriate boxes checked.

Shutdown

1. Shutdown the DAM, by clicking the "X" in the upper right-hand corner of the screen.
Common Database

LOCATION

MPR_SCS_SERVER located in the Control Room.

PURPOSE

The Common Database is a SQL Server 7.0 database which serves as the central repository for raw data and information (higher level decisions based on raw data). The database has an Open Database Connectivity (ODBC) connection to each of SCS modules operating throughout the ship. Each module can read, write, update, or delete information contained in the Common Database. A third party user can access data in the database providing they properly create an ODBC connection and log into their PC as user name: “Administrator”, and password: “admin”.

OVERVIEW

A thorough database structure is provided in Appendix A. Instructions for creating an ODBC connection are provided in Appendix B.
10 PreHit Interface Module

LOCATION

Shadwell-PC5 located in the Control Room or
MPR_SCS_COMM located in DCC

PURPOSE

The PreHit Interface Module simulates Combat Systems information supplied from the Combat Information Center (CIC). Information such as track name, range, angle of attack, hit point location are all simulated and managed. This module can be used in conjunction with a live fire exercise or a simulation/demonstration exercise used in conjunction with the Fire Spread Simulator Module mentioned below. The PreHit Interface Module controls information regarding an imaginary hostile track and a subsequent missile launch until missile impact.

OVERVIEW

The PreHit Interface Module provides a background scenario to the live fire exercise, training or demonstration, adding a degree of realism to the evolution. The concept represents a fully integrated ship where all computer systems from Combat Systems, Damage Control, Engineering, and Navigation are connected and share relevant information to maximize ship readiness. The PreHit Interface Module simulates key information supplied by Combat Systems to the SCS that would improve the performance of Damage Control activity.
Threatening Track Info

The current platform information will appear in the table of the PreHit Interface Module main view. The fields are as follows:

- **Name** – The scenario name entered in the “Add Scenario” Window.
- **Scenario Started** – This field will be “No” until the “Start Scenario” button has been clicked and will remain as “Yes” until the “Reset Scenario/Clear Predicted Damage” button is clicked. The SCS is unaware of any of the information contained in the PreHit Information Module while the scenario is stopped. The SCS is exposed to select information only when the scenario is in progress at certain times during the scenario.
- **Predicted Severity** – This is the hypothetical size (small, medium, or large) of the weapon in general terms and is not meant to represent any particular warhead. This information is not available to the SCS.
- **AOA (Angle of Attack)** – The expected angle of impact relative to the perpendicular of the “hitpoint side” (see below) of the ship. Ninety degrees is perpendicular to the side of the ship, while zero degrees is parallel to the side of the ship. This information is made available to the SCS only after the weapon has been launched.
- **Hitpoint Side** – Port or Starboard. The side of the ship the platform is maneuvering and the expected side of impact of the weapon. This information is available to the SCS while the scenario is running.
- **Hitpoint Location** – The DC compartment number of expected detonation location. This information is only available to the SCS after the weapon has been launched.
- **Attack Likely** – This field initially is “Yes” if the “Platform Likely to Attack” check box in the “Add Scenario” window is checked. The field also can be toggled using the “Toggle Attack Likely” button. This information is available to the SCS while the scenario is running.
- **Initial TTSR (Time to Strike Range)** – This is time entered in the “Time to Reach Strike Range” field in the “Add Scenario” window. This information is not available to the SCS.
- **TTSR** – This value counts down the time to strike range from the “Initial TTSR” value to zero when the scenario has been started only if the “Platform In Range” (see below) is “No.” This information is available to the SCS while the scenario is running.
- **Platform In Range** – This field is “Yes” if the “Platform is Within Strike Range” check box was checked in the “Add Scenario” window or if the TTSR reaches zero. The “Platform In Range” field will be “No” if the “Platform is Within Strike Range” check box was not checked and TTSR is greater than zero. This information is available to the SCS while the scenario is running.
- **Initial TTI** – This is the time entered in the “Initial Threat TTI” field in the “Add Scenario” window. This information is not available to the SCS.
- **TTI** – This value counts down the time to impact from the “Initial TTI” value (see above) to zero when the platform is within strike range, the weapon has been launched, but weapon has not hit the ship. This information is available to the SCS after the weapon has been launched.
- **Weapon Deployed** – This field is “Yes” only when the scenario has started, the platform is within strike range, and the weapon has been launched. This information is not available to the SCS.
• Predicted Damage Applied - This field is “Yes” only after a weapon has been launched, and the “Apply Predicted Damage Now” button has been pressed.
• Weapon Has Hit - This field is “Yes” only after the weapon has launched and the TTI (see above) reaches zero.
• Time Post Hit - This is a time in seconds after the weapon has detonated. This time can be used to measure performance of the SCS operator and DC team in a live fire exercise. The clock runs after detonation unless the scenario is paused or reset.

**Threat Control Buttons**

• “Add Scenario” Button – This button launches the “Add Scenario” window used to create a platform to run a scenario.
• “Delete Scenario” Button – This button deletes the platform created using the “Add Scenario” button.
• “Start Scenario” Button – This button activates the hypothetical platform which will stimulate the SCS. The button also starts the TTSR counter if the platform is outside of strike range.
• “Pause Scenario” Button – This button pauses the scenario stopping any counters and clocks, freezing all variables until the “Pause Scenario” button is clicked again.
• “Reset Scenario/Clear Predicted Damage” Button – This button stops the scenario, resets clocks, counters and platform parameters to their initial conditions, and clears any predicted damage that may have appeared on the SCS display.
• “Toggle Attack Likely” Button – This button changes the value of the “Attack Likely” parameter between “Yes” and “No.”
• “Put Platform In Strike Range” Button – This button immediately sets the “Platform In Range” parameter to “Yes” regardless of the TTSR value. Clicking this button allows for immediate launch of the weapon. The button enables when the “Start Scenario” button is clicked.
• “Launch/Activate Selected Threat” Button – This button launches the threat and starts the TTI counter. The weapon will impact the ship when the TTI counter reaches zero. Platform must be within Strike Range before button will be enabled.
• “Apply Predicted Damage Now” Button – This button applies the damage pattern selected in the “Add Scenario” window to the SCS main view. It is not necessary to click this button during a scenario. The SCS will respond differently if and when the button is pressed during the TTI countdown. The damage pattern represents Combat Systems damage estimate based on the known weapon characteristics. The damage patterns used in for the PreHit Interface Module in no way represent true damage patterns based on any weapon effects data. The damage patterns selected are arbitrary, some designed to coincide to test spaces and scenarios aboard the SHADWELL.

**Scenario Status**

The “Current Scenario Status” region summarizes the position in the simulation evolution. Text will read as follows:
• “No Hostile Platforms” – Occurs when the “Hostile Platforms Grid” at the top of the window is empty. Click the “Add Scenario” button and fill in the fields as outlined below to add a scenario.
• “Scenario Started” – Occurs when a platform has been created but the scenario has not started.
• “Platform Approaching Strike Range: # second” – Occurs after the scenario has started but before the platform has entered the strike range. The number sign (“#”) is the TTSR variable from the platform grid.
• “Platform Approaching Strike Range : # second : Attack Likely” – Same as above, except notes the “Attack Likely” field in the platform grid is “Yes.”
• “Hostile Platform In Strike Range” – Occurs after the scenario has started and the platform is within strike range, but before the weapon is launched.
• “Hostile Platform In Strike Range : Attack Likely” – Same as above, except notes the “Attack Likely” field in the platform grid is “Yes.”
• “Weapon Deployed : Time to Impact # seconds” – Occurs after the scenario has started, the platform is within strike range, the “Launch/Activate Selected Threat” button is pressed, but before weapon impact. The number sign (“#”) is the TTI variable from the platform grid.
• “Weapon Hit : Post Hit Time # seconds” – Occurs after the scenario has started and the weapon impacts the ship. The number sign (“#”) is the “Post Hit Time” from the platform grid.
• “Scenario Pause” – Occurs whenever the “Pause Scenario” button is depressed.

The “Pressure Control” area located at the bottom of the main window is no longer used for PreHit simulation.

Adding a Scenario

The PreHit Interface Module creates a “platform,” with a set of characteristics. To create a platform, select the “Add Scenario” button to launch the “Add Scenario” Window. (See Figure 10-2.) Fill out the form to define a platform, and click the “OK” button to complete the scenario creation.

- Scenario Name/Description - The operator enters the name of the platform as it will appear in the PreHit Information Module main view in the “Scenario Name/Description” box. This name is not visible to the SCS or the SCS operator.
- Platform is Within Strike Range - This box sets the initial distance of the platform from the ship. Strike range, for the purpose of the SCS, is defined as the maximum range of the hostile platform’s weapons. The hostile platform is able to launch a weapon capable of reaching the ship when it is within strike range. Since this is not meant to be accurate, the strike range is an arbitrary value irrelevant to the SCS.
- Initial Threat TTI (Time to Impact) – This is a predefined time in seconds after the weapon is launched until impact.
- Platform Likely to Attack - This check box is a Combat Systems decision based on all known platform data. This check box summarizes Combat Systems data such as the platform’s position, direction, maneuvering behavior, radar signature and communication.
history into one data point for the SCS to use. Setting the state of this check box sets the initial characteristics of the platform.

- Time to Reach Strike Range - This box sets the initial time for the platform, initially outside of the strike range of its weapons, to get within range and pose a threat to the ship. **This is an arbitrary time not meant to simulate any particular threat’s speed or weapon characteristics.** If the “Platform is Within Strike Range” check box is already checked the platform will start within strike range and the number entered in the “Time to Reach Strike Range” will be irrelevant.

- Select a Threat Scenario to Associate with this Platform - The damage associated with the weapon can be selected once the platform’s initial conditions have been defined. The list on the left of the “Select a Threat Scenario to Associate with this Platform” represents predefined damage scenarios. The list on the right defines the particular damage that is associated with the Threat Name in the left list. The threat should roughly coincide with the planned actual damage if the PreHit Interface Module is used in conjunction with a live fire exercise. Any damage plan may be created or selected if the PreHit Interface Module is used in conjunction with a non-live fire demonstration or simulated training exercise.

- “OK” Button – This button finalizes the platforms initial conditions and damage pattern and closes the “Add Scenario” window.

- “Cancel” Button – This button closes the “Add Scenario” window without creating a new platform.

---

**Running a Scenario**

1. Add a scenario (if the table is empty) using the “Add Scenario” button, filling in the fields as outlined above.
2. Click the “Start Scenario” button to begin the simulation.
3. (Optional) Click the “Put Platform In Strike Range” button to place the platform in strike range prematurely for the element of surprise.
4. (Optional) Toggle the “Attack Likely” button. Different states will invoke slightly different responses from the SCS.

5. Click “Launch/Activate Selected Threat” button once the platform is within strike range to launch the weapon. This will begin the TTI countdown.

6. (Optional) Click “Apply Predicted Damage Now” button at any time after launch prior to weapon impact. Varying the TTI when the predicted damage is applied, or not applying it at all will vary the response of the SCS.
11 Fire Spread Simulator Module

Figure 11-1. Fire Spread Simulator Module

LOCATION

MPR_SCS_COMM located in DCC

PURPOSE

The Fire Spread Simulator updates the Common Database with real time thermocouple information based on the damage profile selected. (See Figure 11-1.) The damage profile can be linked to the PreHit information being used in the PreHit Interface Module discussed in Section 10. The fire simulation begins when the “Time to Impact” (TTI) on the PreHit Interface Module reaches zero. The simulation program interacts with the user’s commands providing a dynamic simulation useful for SCS demonstration or personnel training without live fires.

OVERVIEW

The Fire Spread Simulator Module is used for training or for demonstrations when live fire exercises are not practical. It operates independently from the SCS, updating thermocouple data in the Common Database based on simple fire spread algorithms, the automated response of the
SCS, and operator input into the SCS. The operator can simulate fires of various initial sizes, igniting in one or many compartments simultaneously, with any temperature growth rate.

The operator or training coordinator can select the primary compartment(s) from “Select Primary Fire Spaces” window. A primary space in this application is defined as a space with an active fire. The user can select a single fire compartment by clicking on a compartment. A multi-compartment fire can be selected by clicking on multiple compartments while holding down the control key (<CTRL>).

Primary fire compartments can automatically be chosen, by selecting one of the damage scenarios from the PreHit Interface Module. The bottom window contains the names of different threat descriptions created in the PreHit Interface Module. Checking the “Link PreHit Scenario to Damage” box enables the bottom window. Selecting one of the threat descriptions automatically highlights the appropriate primary fire compartments for that scenario. Compartments can be added or subtracted by holding down the control key (<CTRL>) and clicking compartments in the “Select Primary Fire Spaces” window.

The “Primary Growth Rate” box sets the rate of temperature rise for the compartments selected in the “Select Primary Fire Spaces” window. The application will drive the thermocouple temperatures in the primary spaces upward at the rate specified in the “Primary Growth Rate” box when a simulation is running if the fires are left “unattended” by the SCS and operator.

The text box at the bottom left will become enabled if the simulation is linked to a PreHit scenario. This is a primary space’s initial temperature when the simulation is started, used to represent an explosion or instantaneous step change in temperature. The temperature will grow from the current database compartment temperature at the rate specified in the “Primary Growth Rate” box if this box is disabled. The temperature will grow from the temperature set in the box at the rate listed in the “Primary Growth Rate” box if this box is enabled.

This simulation begins when the operator clicks the “Start Simulation” button. The application determines which compartments surround the selected primary compartments. The temperature of vertical compartments located immediately above the primary compartments increase at a rate of 15% of the “Primary Growth Rate”. Secondary compartments are located adjacent to the primary compartments. Their temperatures increase at a rate of 12% of the “Primary Growth Rate.” Tertiary compartments are adjacent to the secondary compartments which are not already primary compartments and their temperatures increase at a rate of 1.4% of the “Primary Growth Rate.” This gives a realistic although not scientifically accurate temperature profile for the selected compartments.

After the simulation starts, each of these compartments is listed in the “Active Fire Spaces” window and labeled as “Primary”, “Secondary”, “Tertiary”, or “Vertical.” A summary of information about the selected space is presented below the window if a compartment is selected from the “Active Fire Spaces” window. The information is as follows:

- Thermocouples Installed? – This is a Yes/No box stating whether thermocouples are currently installed in the compartment on the ship. The temperature of the compartment will still be simulated as it will affect the temperature of surrounding compartments but
the data will not be updated in the Common Database if there are no thermocouples in the compartment.

- WM Engaged? – This is a Yes/No box stating whether the WaterMist system in a compartment is currently hypothetically engaged. This box will be “No” if the compartment’s WaterMist system is not engaged or there is no WaterMist coverage in the compartment. This box will read “Yes” if there is WaterMist coverage and the system is engaged for the compartment. The temperature modeling will take into account the effect of the WaterMist if the system is hypothetically engaged.

- Manual Fire Attack? – This is a Yes/No box stating whether a hypothetical fire attack team is currently attacking the fire in the space. The temperature modeling will take into account the effect of a hypothetical fire attack team actively fighting the fire in the compartment.

- Current Sim. Temp. – This box gives the current simulation temperature (°C) for the compartment. The temperature is updated in real-time based on the simulation characteristics.

The Fire Simulation Module updates the thermocouple data for initial primary spaces in the Common Database as if it were damaged as expected in the immediate vicinity of an explosion when this simulation is linked to a PreHit scenario. The temperatures of the initial primary spaces are internally trended to model the surrounding temperatures but are not updated in the Common Database. A temperature of -1000°C is placed in the Common Database, it is the responsibility of the SCS to interpret the damaged sensor data.

The secondary compartments become primary compartments when their temperatures increase to the point where spontaneous ignition of material located against bulkheads shared with primary compartments is likely. A secondary compartment will be recategorized as a primary compartment assuming the “Primary Fire Growth Rate” if its ambient temperature reaches 75°C. All of the compartments surrounding the new primary compartment will be classified as secondary spaces (if not already), all of the new secondary compartments will be surrounded by tertiary compartments. This process continues and the “fires” spread if left unhindered.

There are several defensive mechanisms that will counter temperature increases and fire spread:

- WaterMist Fire Boundaries and Fire Suppression – Engaging the WaterMist system in a compartment applies a negative growth factor of -120°C/min to current temperature growth rate for the compartment in question. Engaging the hypothetical WaterMist system would result in a temperature growth rate of -60°C/min, decreasing the compartment temperature if the temperature growth rate for a compartment was 60°C/min. There would not be a decrease in the compartment temperature if the temperature growth rate was greater than 120°C/min. This would only serve to negate or slow the temperature rise. The temperature growth rate returns to its normal value and the temperatures will begin to increase again if the WaterMist is secured.

- Manual Fire Boundaries and Fire Attack – Establishing a hypothetical manual fire boundary in a compartment applies the same negative temperature growth rate as for WaterMist. The temperature growth rate in a boundary compartment returns to its previous value when the boundaryman is removed. The temperature growth rate in a fire
Clicking the “Stop Simulation” button pauses the simulation retaining all of the data. This feature is useful in training or demonstration situations when instruction or explanation is required, preventing the simulation from proceeding until the operator is ready. Clicking the “Start Simulation” resumes the simulation.

Clicking the “Reset All Compartment Damage/Deactivate All Water Mist” resets all of the Common Database ship’s thermocouples entries to 23°C (normal room temperature) and secures the hypothetical WaterMist system. The Fire Simulation Module is reset and ready to begin another simulation.

Running a Single Point Fire Scenario

1. Click “Reset All Compartment Damage/Deactivate All WaterMist” button to reset all information to initial conditions in the Common Database.
2. Enter the primary fire growth rate in the “Primary Growth Rate (deg/min)” text box.
   NOTE: Growth rates for small peace-time fires are typically less than 100°C/min.
3. Select the fire origin compartment from the “Select Primary Fire Spaces” list box.
   NOTE: Multiple compartments can be selected by holding down the <CTRL> key while making selections.
4. RETURN TO SECTION 3 NOW, IF INITIALLY DIRECTED TO SECTION 11 FROM SECTION 3.
5. Click the “Start Simulation” button.
6. Click the “Stop Simulation” button when the exercise is over.
7. Click “Reset All Compartment Damage/Deactivate All WaterMist” button to reset all information to initial conditions in the Common Database.

Running a Mass Conflagration Fire Scenario

1. Click “Reset All Compartment Damage/Deactivate All WaterMist” button to reset all information to initial conditions in the Common Database.
2. Enter the primary fire growth rate in the “Primary Growth Rate (deg/min)” text box.
   NOTE: Growth rates for large casualties are typically between 100°C/min and 200°C/min.
3. Check the “Link PreHit Scenario to Damage” checkbox.
4. Select the damage scenario from the bottom list box.
   NOTE: Select the same scenario as used in the PreHit Interface Module if using the PreHit Interface Module in this evolution.
5. Enter an initial post hit compartment temperature in the text box at the bottom of the interface.
6. RETURN TO SECTION 3 NOW, IF INITIALLY DIRECTED TO SECTION 11 FROM SECTION 3.
7. Click the “Start Simulation” button.
8. Click the “Stop Simulation” button when the exercise is over.
9. Click "Reset All Compartment Damage/Deactivate All WaterMist" button to reset all information to initial conditions in the Common Database.
12 Firemain Interface Module

Figure 12-1. Firemain Interface Module

LOCATION

MPR_SCS_TEST located in the Control Room

PURPOSE

The Firemain Interface Module [4] handles data transfer on and off the LonWorks network where all of the ex-USS SHADWELL's firemain components reside. (See Figure 12-1.) The program updates the Common Database with the current valve positions, pump speeds and sensor readings, and sends control requests to the firemain components that are placed in the Common Database by other SCS modules.

OVERVIEW

The Firemain Interface Module communicates with the LonWorks based firemain valves, pumps, and sensors via the PCLTA-10, a LonWorks PCI interface card. The MPR_SCS_TEST
PC is the only PC capable of running the Firemain Interface Module because it is the only PC that contains a PCLTA-10 card.

The left side of the Firemain Interface Module contains firemain component connection information, while the right side of the screen contains firemain component data and command information. When the interface module is started, it is not automatically connected to the networked firemain components. Enter the appropriate network name into the “LONWORKS Network Name” text box. (The current network name as of February 2002 is “shadwell_01_02.”) Entering different network names into the Firemain Interface Module allows the program to monitor and control different subsets of LonWorks components. Currently “shadwell_01_02” contains all of the functioning LonWorks valves, pumps, and instruments and is the only active LonWorks network that can be controlled from this application.

The “DDE Connection Info” window lists all of the components that were selected to be connected. The items in this list are controlled by a database entry located in the Common Database called “ShouldConnect” in the “LONWORKSDDENODES” table. Updating that column and restarting the Firemain Interface Module will update the list of components in the “DDE Connection Info” window.

Clicking the “Connect to the DDE Server” button begins the connection process. The program tries to establish a network connection, scanning the variables from each firemain component in the “DDE Connection Info” window. The “Connection Status” starts as “Not Connected”, changes to “In Progress...” while the connections are attempted, changes to “Connected” with a green check box when the network connections to a device are complete, or “Failed” with a red “X” in the check box if the connection was not successful. After the first connection attempt for all of the devices, the program will prompt the user to attempt a second connection for the devices that failed the first connection attempt. If the second connection attempt fails, the components will remain unable to communicate with the rest of the SCS. The entire network can be reconnected by clicking the “Disconnect from DDE Server” button, then clicking the “Connect to the DDE Server” button again, or by closing the application and repeating the connection procedure again.

The “Skip Next” button can be clicked if there is a known problem with a networked component and the connection attempt shouldn’t continue. This will speed up the overall connection time because the application will not wait for the skipped component to respond, automatically moving to the next component in the list.

The “Skip Remaining” button can be clicked if the connection process needs to be aborted. Clicking this button leaves the component connections already established in tact. Clicking the “Cancel All” stops the current connection process. This button functions identically to the “Disconnect from DDE Server” button, but the “Cancel All” button can be used during the connection process, while the “Disconnect for DDE Server” button can only be used after the connection attempts are complete.
Data logging and command execution automatically begin once any or all of the components are connected. The Firemain Interface Module monitors the “Actions Request” table of the Common Database for requests from other SCS modules to control firemain components, formats the request and passes the command to the component via the LonWorks network. The command information and status is posted in the “Received Command Requests” window. A summary of the command function, component and request time are posted for each command request. A check mark appears in the “Completed” column, along with a timestamp if the requested command is issued to a component. A checkmark is placed in the “Rejected” column if the software module issuing the command did not have the correct authority to control a firemain component or if the request made in the database was not in the proper format.

The “Received DDE Callback Messages” window provides a scrolling summary of the messages received from the LonWorks components. Each message contains a device name, variable name, variable data and a timestamp of when the message was received.

The Firemain Interface Module updates the Common Database with the firemain component data, when each message is received, only if the data is different from the data currently in the database. This minimizes the number of unnecessary Common Database updates, decreasing network bandwidth and CPU usage while increasing SCS performance.

The “Processed DDE Callback Messages” window and “Refresh” buttons are no longer used.

**Startup**

1. Enter the appropriate network name into the “LONWORKS Network Name” text box.
2. Click the “Connect to the DDE Server” button to begin the connection process.
3. Attempt a second connection, if the initial connection attempt fails to connect to all of the components.
4. Restart the application (following Startup Steps 1-3), if the second connection attempt fails to connect to all of the components.

**Shutdown**

1. Click the “Disconnect from the DDC Server” button to sever the network connection to the firemain components.
2. Click the “Exit” button to log off from the SCS and close the application.
13 WaterMist Interface Module

LOCATION

MPR_SCS_SERVER located in the Control Room (but can be located anywhere the SCS WaterMist Decision Aid Software Module is operating)

PURPOSE

The WaterMist Interface Module [2] handles data communication to the WaterMist valves over the ship’s Ethernet network. (See Figure 13-1.) The program sends control requests placed in the Common Database by other SCS modules to the WaterMist valves. The module communicates via National Instruments “Virtual Port” software to a TCP/IP addressable receiver, which then communicates with an IOTech Black Box. The Black Box is hardwired to a relay panel and the valve actuators are controlled via the relay panel.

OVERVIEW

The PC responsible for executing the WaterMist Decision Aid Software Module locally launches the WaterMist Interface Module. The existing instance of the WaterMist Interface Module closes and a new instance launches local to the new instance of the WaterMist Decision Aid Software Module, if the WaterMist Decision Aid Software Module is reassigned to another PC.
The WaterMist Interface Module processes and executes valve actuation requests placed in the Common Database by the WaterMist Decision Aid Software Module. The WaterMist Interface Module translates the valve requests into a format the IOTech devices in the test area can use to activate or deactivate the relay for the appropriate valve.

The WaterMist Interface Module has no user interface; start up and shut down are controlled by the parent WaterMist Decision Aid Software Module. The “WM DAM Connected” light turns green when the WaterMist Interface Module detects the presence of the WaterMist Decision Aid Software Module. The “WM Serial Connection” lights turn green when positive communication links are established with IOTech devices in the test area. There is one light for each of the two IOTech devices. A “WM Serial Connection” light turns red when the data connection with an IOTech device is broken.

The “WM DAM Receiving Data” light turns green while a new WaterMist valve actuation request is being retrieved from the Common Database and turns red when actuation request retrieval is complete. The “WM Serial Sending Data” light turns green while an actuation request is processed and dispatched to the corresponding IOTech device for a particular valve. The “WM Serial Sending Data” light turns red after the actuation message is sent.

There is no positive feedback from the IOTech box or the valve to acknowledge a message was received or a valve responded correctly to the command because there are no position measurement devices installed on these particular WaterMist valves. The WaterMist Interface Module updates the Common Database to notify other software modules the action has been executed. Successful valve actuation can be inferred through live video or real-time environmental data collected for the compartment.

**Startup**

The WaterMist Interface Module is automatically started by its parent system, the WaterMist Decision Aid Software Module. No operator action is required.

**Shutdown**

The WaterMist Interface Module is automatically secured by its parent system, the WaterMist Decision Aid Software Module. No operator action is required.
Door Closure Interface Module

![MPR Supervisory Control System Access Closure Monitoring Interface](image)

**Figure 14-1. Door Closure Interface Module**

**LOCATION**

MPR_SCS_TEST located in the Control Room

**PURPOSE**

The Door Closure Interface Module processes door status data from the NRL maintained Door Closure Database over the ship's Ethernet network. (See Figure 14-1.) The program interface module polls the Door Closure Database for changes in door status and updates the Common Database with the new door position data. The NRL maintained Door Closure Database is an MS Access database that interfaces to a PLC via a custom designed Wonderware GUI.[5]

**OVERVIEW**

The Door Closure Interface Module establishes a connection via ODBC to the NRL maintained Door Closure Database. (See Appendix B regarding establishing an ODBC connection.) If the Door Closure Database is not in the predefined ODBC location, the name of the database has changed, or the data in the database is not presented in the proper format, the program will notify the operator that the connection cannot be established. The problem must be rectified before the Door Closure Interface Module can supply door status data to the Common Database. The Door Closure Database is scanned for changes every second, once a connection has been established. The Interface Module updates the door status change in the Common Database along with an updated time stamp depicting the time of the door position change when a change in door position is detected. The Interface Module updates the Common Database only when a door
status changes, minimizing the number of unnecessary Common Database updates, decreasing network bandwidth and CPU usage while increasing SCS performance. The installed door sensors determine if the door is open, closed or closed and dogged. There is also an error signal signifying a problem with the sensor or the door. During a casualty scenario a damaged door sensor can help define the extent of damage and functionality of the door.

The “Door Text” text box contains the door identification information contained in the NRL maintained Door Closure Database when a change in door status is detected. The “Description” text box then contains the Common Database’s identification information for the same door. A “No Matching Door” is posted in the “Description” text box if a matching door is not found in the Common Database. The “Position” text box contains a numerical code from the Door Closure Database for the door status. This code is translated into different SCS codes which appear in the “OpenClosed” and “StatusID” test boxes. The “Last Updated” text boxes on each side display the last time the door status was updated in the Door Closure Database and the SCS Common Database. The “Last Checked” text box displays the last time the Door Closure Database was polled for changes.

All of the fields will be blank and the “Last Checked” text box will display a continually updating time of when the Door Closure Database was last polled when there are no door status changes.

**Startup**

1. Start the NRL Door Closure Database and Wonderware PCL application per the NRL Door Closure System Operating Manual.[5]
2. Start the Door Closure Interface Module, by clicking on the icon located on the desktop of the MPR_SCS_TEST computer.

**Shutdown**

1. Double click on the Door Closure Interface Module to log off from the SCS and close the application.
2. Secure the NRL Door Closure Database and Wonderware PCL application per the NRL Door Closure System Operating Manual.[5]
15 Early Warning Fire Detection System (EWFDS) Interface Module

LOCATION

MPR_SCS_TEST located in the Control Room

PURPOSE

The EWFDS Interface Module receives EWFDS [6] sensor updates via a standard TPC/IP port connection from the EWFDS primary PC and updates the Common Database with the new values. (See Figure 15-1.)

OVERVIEW

Upon startup, the EWFDS Interface Module automatically connects with EWFDS primary PC located in the test area. The “Connection Status” text box is “SERVER NOT RESPONDING” and the “Transfer Status” text box is “TRYING TO CONNECT” while trying to connect to the
The “Connection Status” text box is updated to “CONNECTED” when the EWFDS PC host establishes a TCP/IP connection with the EWFDS Interface Module. Data packets are sent to the EWFDS every second. The “Transfer Status” text box while receiving is “NEW DATA SENT”. The EWFDS PC, located in the test area, feeds the EWFDS Interface Module two data points for each EWFD sensor: the probability of alarm (between 0 and 1) and the alarm status flag (TRUE or FALSE.) The EWFDS updates the Common Database only when the probability of alarm changes by more than 2% from the previous value or the alarm flag state changes to minimize the number of unnecessary Common Database updates, lowering network traffic and database usage, while increasing overall SCS performance.

The “Number of Dropped Connections” text box increments by one each time the EWFDS Interface Module loses the established TCP/IP connection. The date and time of the last dropped connection is noted in the adjacent box. When a connection is lost, the EWFDS Interface Module reverts back to trying to establish a connection. Data transfer begins again once the connection is reestablished. The date and time reported will be the date and time the EWFDS Interface Module was opened if the Number of Dropped Connections is “0.”

**Startup**

1. Start the NRL EWFDS host system in the test area per the EWFDS Operating Manual.[7]
2. Start the EWFDS Interface Module, by clicking on the icon located on the desktop of the MPR_SCS_TEST computer.

**Shutdown**

1. Double click on the EWFDS Interface Module to log off from the SCS and close the application.
2. Secure the EWFDS host system in the test area per the EWFDS Operating Manual.[7]
MASSCOMP Interface Module

**LOCATION**

MPR_SCS_SERVER located in the Control Room

**PURPOSE**

The MassComp Interface Module receives environmental sensor updates via a standard TPC/IP port connection from the MassComp and updates the Common Database with the new values. (See Figure 16-1.) The module can also create a historical text file of the data received from the MassComp for future reference.

![Figure 16-1. MassComp Interface Module](shadwell_masscomp_interfaces.png)
OVERVIEW

Upon startup, the MassComp Interface Module automatically connects with MassComp located in the control room if the MassComp is currently collecting data ("scanning"). The message box in Figure 16-2 will appear if the MassComp is not on-line and collecting data. Selecting “No” will launch the MassComp Interface Module but will not connect to the MassComp nor log data to the database. Selecting “Yes” will attempt to reestablish the connection to the MassComp. This message box will reappear if the connection attempt was unsuccessful. The MassComp Interface Module will launch and data logging will begin automatically if the connection attempt was successful. The channel list that the MassComp is scanning must correspond to the instruments in the test area. It must also coincide with data channels pre-selected by SCS.

![FireData dialog box](image)

**Figure 16-2. MassComp Connection Error Message Box**

The IP and port address of the MassComp is connected to or trying to connect to is shown in the “Server IP Address” and “Server Port” text boxes respectively. The IP is set to “89.0.0.1” and the port is set to “10000” by default. These are the current settings to connect to the MassComp.

The “Event Log Window” reports the current status of the MassComp Interface Module and updates when a new batch of data is received.

The “MassComp Channels Window” shows all of the sensor entries in the MassCompData Table in the Common Database along with their associated properties and current values.

Clicking “Connect” button will attempt another connection with the MassComp if the module is not already connected to the MassComp. The button will read “Disconnect” when the module is connected to the MassComp. Clicking this button will close the current connection to the MassComp and the button text will reset to “Connect”. The “Clear Log” button will clear the internal buffer that contains all of the data updated to the database during the current session. The “Save Log” button saves the information contained in the internal buffer to a text file, clears the internal buffer and begins a new text file and internal buffer. The “Exit” button disconnects the module from the MassComp and closes the application.

The module processes a batch of information from the MassComp and updates the sensor values in the Common Database that have changed significantly and includes an updated timestamp when “Update Database on Packet Receive” checkbox is checked. If the box is not checked, the data is not updated in the Common Database. This checkbox must remain checked for the SCS to function properly.
The “Write Data to Disk Log on Receive” checkbox dictates whether the data received from the MassComp is written to the historical text file each time a batch is received (checked) or only at the end of a session (unchecked). This box should be checked if the module will be running for an extended period of time (more than a day). This keeps the internal buffer size small but slows down the execution speed of the application slightly. This box should remain unchecked if the module will be running for less time. This results in a larger internal buffer because all data is being retained until the connection is closed, but the execution time is faster because the data is not written to a file each time a batch is received.

The “Automatically Refill Spreadsheet” checkbox determines if the batch data received from the MassComp is updated in the “MassComp Channels Window” located at the bottom of the module. The spreadsheet will update the “Value” column and the “Last Reported” column for each sensor for each batch received but will slow the execution speed of the module slightly if the checkbox is checked. Data will not be updated in the spreadsheet if the checkbox is unchecked and as a result the module will execute slightly faster. This checkbox does not control whether the data is updated to the Common Database. That is controlled by the “Update Database on Packet Receive” checkbox.

**Startup**

1. Start the MassComp per MassComp startup procedures.
2. Start the MassComp Interface Module, by clicking on the icon located on the desktop of the MPR_SCS_TEST computer.

**Shutdown**

1. Double click on the MassComp Interface Module to disconnect from the MassComp and close the application.
2. Secure the MassComp per MassComp procedures.
References

Figure A-1. SCS Database Table Structure
Establishing an ODBC Connection

Open Database Connectivity (ODBC) is a standard or open application programming interface (API), for accessing a database. Most Windows PC’s with Microsoft Office or Microsoft Access installed contain the ODBC library and associated drivers. It is assumed from this point on that ODBC is installed on your computer. One way to verify whether or not you have ODBC installed is to look for the “ODBC Data Sources” icon in the Windows Control Panel on Windows 95, 98 and NT 4.0 or look in the “Administrative Tools” folder in the Windows Control Panel if using Windows 2000 and XP. Note that since the SCS SQL Server central database is located on a remote server computer, you must have Microsoft Networking installed with the TCP/IP protocol configured. The computer must have at least a 10 base-T Ethernet card and a unique IP address provided by the SHADWELL staff in order to connect to the SHADWELL Ethernet LAN. If your computer is not properly configured to interface with the SHADWELL data network, you will not be able to “see” the server computer, which will cause the data source creation process to fail.

It is necessary to create an ODBC Data Source in order to access the SCS Common Database. The ODBC data source acts as a translator between a client application located on a remote computer and the SCS Common Database located on the “MPR_SCS_SERVER” computer. Below are detailed instructions for creating a SQL Server 7.0 ODBC data source on your PC and configuring it to work with the SCS Common Database.

The steps are as follows:

1. Press “Start Button” at the bottom of the Windows desktop
2. Select “Setting” → “Control Panel”
3. Open “ODBC Data Sources”
4. Select the “System DSN” tab at the top of the ODBC Data Source Administrator Window (Figure B-1 – Arrow 1)
5. Click the “Add” button. (Figure B-1 – Arrow 2)

Contact An Nguyen, 251-433-0353, to obtain an IP address for use on the SHADWELL.
6. Select “SQL Server” from the list of drivers for the data source (Figure B-2 – Arrow 1).
7. Click the “Finish” button (Figure B-2 – Arrow 2).

8. Fill out the name of the data source as “Shadwell Database” (Figure B-3 – Arrow 1).
9. Fill out the description field with a useful description of the data source, such as the text in the description field (Figure B-3 – Arrow 2).
10. Fill the SQL server field with the name of the server computer that contains the database. In this case, enter “MPR_SCS_SERVER” to connect to the SCS Common Database (Figure B-3 – Arrow 3).
11. Click the “Next” button (Figure B-3 – Arrow 4).
12. Select the 1st radio button option, which uses the operating system to authenticate the user (Figure B-4 – Arrow 1).
13. Click "Next" button (Figure B-4 – Arrow 2).

After Step 13, the computer will try to connect to the SQL Server database. If the test connection is successful, a message window will appear saying so. If the test connection is not successful, ensure that the server computer is turned on and connected to the network. Also check to see that the NetBEUI networking protocol is installed in your computer’s Network Settings in the Control Panel. After the problem has been corrected, repeat steps 1-15 until the connection to the database has been established. For specific assistance with the ODBC data sources, contact Ryan Downs at MPR at 703-519-0200.
Modifying the MASSCOMP Channel Listing

The MASSCOMP supplies real-time environmental data (thermocouples, smoke density) to the SCS via the MASSCOMP Interface Module. Each sensor must be properly mapped to the correct compartment for the SCS to accurately detect casualty conditions and, predict and track fire and smoke spread. A mismatch between sensor type, location or MASSCOMP channel would lead to incorrect SCS functionality.

RELEVANT DATABASE TABLES

Figure C-I shows the relevant fields in the MassCompData Table and the ShadwellSpaces Table. Each instrument connected to the MassComp is listed in the MassCompData Table and each compartment on the ship is listed in the ShadwellSpaces Table. Instruments can be added, permanently removed, temporarily deactivated, or reassigned to another location by changing the entries in the MassCompData Table to coincide with the physical sensor arrangement and wiring to the MassComp. A sensor entry has the following values that must be set:

- The “ID” field is a unique integer identifier for each sensor. The value is automatically assigned by the SQL Server and is irrelevant to the user.
- The “CollectThisInstrument” field allows a “1” or “0”. The sensor manager can select which sensors are valid and available without adding and deleting sensors from the table for every test evolution.
- The “Instrument Description” field is a text field where the sensor manager can provide additional information regarding the specific sensor location such as, “2-18-0 TC tree 8ft off deck”.
- The “Instrument Type” field is a text field that assigns the instrument class. Valid instrument classes are “thermocouple”, “ODM”, “pressure”, “flow”, “CO2”, “CO” and “O2”.
- The “MassCompChannelNum” field is a text field that ties this sensor entry in the MassCompData Table to a physical channel on the MassComp. The channel number MUST start with an “A” or “B” and have a three-digit number between “001” and “200.” Examples include “A005” or “B148” (without “”). Random data values will be output to the database decreasing the accuracy of the SCS if there is no instrument plugged into that particular MassComp channel where the “CollectThisInstrument” field is “1”. Disable the channel in the database by setting the “Collect This Instrument” field to “0” if there is no sensor connected to the channel.
- Instruments are assigned to the proper compartment using the “SpaceLocID” field in the MassCompData Table. The “SpaceLocID” is a unique integer identifier generated in the ShadwellSpaces Table and is used throughout the SCS to link items such as sensors, valves and pumps to particular compartments. Only valid values for the “SpaceLocID” obtained from the ShadwellSpaces Table are allowed as values for the “SpaceLocID” field in the MassCompData Table.
The ShadwellSpaces Table contains a list of compartments on the ship. For the purposes of reconfiguring the sensors linked to the MassComp, no data should be changed in this table. The ShadwellSpaces Table should only be used to look up the compartment identifier, "SpaceLocID", to use in the MassCompData Table. Relevant fields in the ShadwellSpaces Tables are as follows:

- The "SpaceLocID" field is a unique integer identifier for each compartment. The value is automatically assigned by the SQL Server. This number cannot be changed.
- The "SpaceDCNum" field is a text field that contains the damage control compartment designation in the standard format "D-FFF-O-X", where "D" is the deck number, "FFF" is the frame number, "O" is the centerline offset number and "X" is the compartment class designation. Examples include "2-15-0-C" or "2-24-2-L" (without " ").
- The "SpaceName" field is a text field that contains the common noun-name for the compartment.

![Figure C-1. MassComp Table, ShadwellSpaces Table and MassComp Dependent Relationship](image)

**INSERTING A NEW INSTRUMENT**

1. Open the SQL "Enterprise Manager".
2. Open successive folder until the "ShadwellDB" folder appears in the list.
3. Open the "ShadwellDB" folder.
4. Select "Tables" from the list on the left window pane.
5. Right-click on “MassCompData” from the list on the right window pane and select “Open Table” ➔ “Return All Rows”.
6. Scroll to the end of the list.
7. Start populating the last row which will be blank and denoted by the “*” in the left column, with the following information: “CollectThisInstrument”, “InstrumentDescription”, “InstrumentType”, “MassCompChannelNum” and “SpaceLocID”.
   - DO NOT attempt to assign a value to the “ID” field. SQL Server will automatically set the “ID” field when the entry is properly completed.
   - DO NOT move the cursor off the row until all five of the above fields are populated with valid data.
   - SQL Server will post an error message, if any of the entered data is incorrect or incomplete.
8. Move the cursor off of the current row to commit the addition to the database.

**DELETING AN EXISTING INSTRUMENT**

1. Open the SQL “Enterprise Manager”.
2. Open successive folder until the “ShadwellDB” folder appears in the list.
3. Open the “ShadwellDB” folder.
4. Select “Tables” from the list on the left window pane.
5. Right-click on “MassCompData” from the list on the right window pane and select “Open Table” ➔ “Return All Rows”.
6. Highlight the entire row for the sensor entry you wish to remove by right-clicking the left-most grey square in the row.
7. Select “Delete” from the context menu box.
8. Move the cursor to a new row to commit the sensor deletion from the database.

**UPDATE AN EXISTING INSTRUMENT**

There are several ways to update an existing entry requiring one or multiple changes to the sensor entry to correctly reassign the sensor.

1. Open the SQL “Enterprise Manager”.
2. Open successive folder until the “ShadwellDB” folder appears in the list.
3. Open the “ShadwellDB” folder.
4. Select “Tables” from the list on the left window pane.
5. Select “MassCompData” from the list on the right window pane.
6. Right-click on “MassCompData” from the list on the right window pane and select “Open Table” ➔ “Return All Rows”.
7. Update the entry with the new data.
8. Move the cursor to a new row to commit the changes to the database.

- If a sensor is in the same location but has moved to a new MassComp channel, update the “MassCompChannelNum” field.
- If the sensor is not currently being used, but may be used in the future, set the “CollectThisInstrument” field to “0”.

C-3
- If the sensor is being reinstated at the same location after a period of inactivity set the “CollectThisInstrument” field to “1”.
- If the sensor has been relocated to a new compartment, look up the new “SpaceLocID” number for the new compartment location for the sensor from the ShadwellSpaces Table and enter it into the “SpaceLocID” field in the MassCompData Table. Update the “InstrumentDescription” with the new specific location and elevation.
- If the sensor type changed, select the appropriate sensor type for the new sensor connected to the MassComp.

NOTE: Each MassComp channel number listed in the “MassCompChannelNum” field can only be assigned to ONE ACTIVE sensor entry. The same MassComp channel number can appear multiple times in the list as long as only one of the entries has “CollectThisInstrument” set to “1”, all others must be set to “0”.

**CHECK FOR A CORRECT SENSOR UPDATE**

It is good practice to ensure the change appears correct in the SCS Display program after an addition, deletion or modification of a sensor entry in the MassCompData Table is complete. To do so, open the SCS Display program as shown in Section 5. Open the Compartment Detail Information Window (See Figure 5-9) for each compartment containing updated sensor information. Ensure the correct sensor information, including exact sensor location, MassComp channel number and instrument type appear in the Compartment Instrumentation window at the bottom of the Compartment Detail Information Window. Check that the “SpaceLocID” field is correct and the “CollectThisInstrument” field is set to “1” for a sensor to link to a compartment. Check that the “CollectThisInstrument” field is set to “0” for a sensor to not link to a compartment.